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Introduction to Advanced
Cataloging

The Advanced Cataloging Workflow-Based Reference Guide contains a variety of
reference topics for performing Cataloging tasks beyond basic functions such as
original or copy cataloging and the creation of item records. The topics covered in
this guide will help you understand how the Virtua™ ILS - Integrated Library
System handles authority control, allows creation of cross referencing, and utilizes
load options to process records in your database.

This guide will also describe specific cataloging settings and system parameters
required for working with bibliographic and item records, as well as InfoStation
reports that pertain to records in your database. For more basic cataloging topics,
please refer to the Basic Cataloging Workflow-Based Reference Guide.
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Understanding Menu & Toolbars

Language and Directionality Options
Language and Directionality options can be set from the Options pull-down menu.

Language
Select a language from the menu list.

Any translated strings for that language will appear in the Client interface.

W Virtua - Headquarters - Customer Support Library E]@
File Search Circulation Acguisiions Cataloging  Options Tools Window Help
W @O | & R|€GE g PO "l DB
Default connection: Customer Support Library - staff Language b Arabic [
Font Azeri
Hyperlink Options. .. Catalan
Directionality r Chinese
] Chinese Trad
Change Location... Nemich
Circulation Options ¥ Dutch
v Sort Patron Account by Location v English
Cataloging Options. .. Finnish
Label Editor... French (Belgium)
Load Options... French (France)
Available Languages. .. French (Switzerland)
German
Toolbars r Greek
Hebrew
Hindi
Icelandic
Indonesian
Inuktitut
Irish
Italian
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Directionality
Select Left to Right soft and all text, regardless of directionality, will left justify

Select Left to Right Soft text that is left-justified text will display left justified and right-
justified text will display to the right.

Select Right to Left and all the text, regardless of directionality, will right justify.

¥ Virtua - Headquarters - Customer Support Library E]@
File Search Circulation Acquisiions Cataloging Options Tools  Window Help

9 T W& i ] b, "
W @O | £ R | € GE| g OO Bl pD B[S
Default connection: Customer Support Library - staff Language r

Font
Hyperlink Options. .. |
Directionality r ® Left To Right ‘

Left To Right Soft

Change Location. .
ange Location Right To Left

Circulation Options »
v Sort Patron Account by Location

Cataloging Options. ..

Label Editor...

Load Options...

Available Languages. ..

Toolbars ¥
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Virtua File Menu

W Virtua - Headquarters - Customer Support Library

==X

MW @0

File Search Circulation Acquisiions Cataloging Options Tools Window Help

AR eE ABE N - Q9F 12 &

Default connection: Customer Support Library - staff

Current connection: Customer Support Library - staff

B DB

Menu bar Icon | Function | Function
Keys

File

Records

Create Select a template to create a MARC
record

Delete Select a file of local records or a
single local record to delete

Edit Local Select a file of local records to edit

Edit Item Modify various elements of item
records with the Batch Item Editor.

Translate Display the Batch Character Set
Translation panel to convert a file of
local records to the Unicode character
set

Import Records Imports records from OCLC, other
bibliographic utilities, and local files

Import to Selection Imports records from a source file

List directly to the Purchase Request List.

Workform

Edit Select a workform to edit

Delete Select a workform to delete

Close Close multiple records or workforms
without closing the Editor itself

Save Record Save changes made to an existing
local record

Save Record As Save local record to a different file or
overwrite an existing local record with
new changes

Append Record To Add record to an existing file of local
records

Save Copy to Duplicates a MARC record and saves it

Database to a designated database

Save to Database F11 Save the record and create index

Save as FRBR
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Save as Combined Save a FRBR record in standard MARC
format.
Delete Record from Remove record from the database and
Database delete index entries
Delete Select a workform to delete
Virtua Edit Menu
W Virtua - Headquarters - Customer Support Library E]@

File Search Circulation Acquisiions Cataloging Options Tools  Window Help

WO AR CeCHEH BE N - 91X & - BLOBE

Default connection: Customer Support Library - staff Current connection; Customer Support Library - staff

Menu bar Ico | Short Cut Function
n
Edit
Cut Ctrl X Cut selected text
Copy Ctrl C Copy selected text
Paste Ctrl V Paste Selected text
Add Tag Shift, Ctrl, A | Add MARC tag
Copy Tag Shift, Ctrl, C | Copy MARC tag
Paste Tag Shift, Ctrl, V | Paste MARC tag
Paste Tag to All Paste MARC tag into all open
MARC records
Delete Field Shift, Ctrl, D | Delete MARC tag
Validate Record AltE, V Starts record validation
Icon only ] Edit 008 tag
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MARC Editor Window

The MARC Editor can be used to:

Create a new record (original cataloging)

Edit a MARC record from the Virtua database

Edit a MARC record from a local diskette, hard drive, or network drive

Edit a MARC record from a bibliographic utility or Z39.50 compliant database

M i - Phoenix%9 Q@

>
I
m
=
-
=]
-

Tags, Indicators, and

-DEH wh=00263299 1= .
| | Fields:
003 [MeFayC Virtua provides a layout of the
|200?0113000500.n tags, indicators, and fields for

| 04092752005  nyub 0001 eng

format record/workform that
Virtua Supports.

Q2=
=g k=2 =
[ ) T

| 5
| 5 e 5

[ 2 2004022863
[12 0318011770 ;e $30.95
[ (DLC)2O04m22563

o
[
[}

|
|
|
| each type of MARC or 2709
|
|
|

%3 200701180005 b YLOAD ' 200506050549 W
btaylor \o 200506030537 'd btaylor \c 200503071745
'y 200503071743 'z mcarthu

| va DLCw DLC W GCmBT

EEET
= F = kOSTOVA,

| N O I

= o2
o) (LN B )
b2 w ||

[ 2 Kostovs, Blizabeth.

I

|(aj Language matetial L| () Monographitern j [ Mazked
< | = M&RC 21 Bib: Book oPac | < Type and Bib Level
DPACI A A Options:
The MARC Editor provides a
. Information Bar: pull-down list boxes showing
Tracking Type and Bib Level Options.
Tabs: The information bar at the bdttom ¢f the The codes for the selected
MARC Editor window indicateg threg thipgs: options are displayed from
The MARC i WARCR1 Bl Bock [perc [ oo the Leader of the MARC
Editor keeps record.
track of the .
records or The type of record being created or 0= y
workforms that edited: USMARC Bib: Book. —
you create or
access during
the current Whether it is a workform or a record
session. and if a record, whether it is New,
— Local, or accessed from the OPAC.
If typing the first entry into the
MARC Editor or adding or deleting a
tag has changed the record, the

word Modified appears on the
Information Bar.
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MARC Editor Menu Options

W Virtua - Headquarters - Customer Support Library E]@
File Edit Search MARC Editor Circulation Acquisitons Cataloging Options Tools Window Help

-;,{' . i U Create Authority Record(s). .. & N B %—;g m E ﬁ L B O i@
Default connection: C nt connection: Customer Support Library - staff

Duplicate Record in Mew Window
Merge Record with Workform...
Card Screen Preview...

Export to VTLS Format...

Remember for Thank You Letter
Insert Unicode Control Character #

¢ Create Authority Records: Allows you to create authority from selected headings
information in an open MARC record.

e Authority Browse: Opens the Browse Search window populated with the
information from the selected tag.

e Authority Keyword: Opens the Keyword Heading Search window populated with
the information from the selected tag.

¢ Duplicate Record in New Window: With a record or workform open in the MARC
Editor, this feature allows you to open a new window that duplicates the first.

¢ Merge Record with Workform: With a MARC record open in the MARC Editor, you
can add tags by merging the record with a workform. Tag not in the record but
that are in the workform will be added to the record.

e Card Screen Preview: Allows you to preview the “public view” of the record you
are editing.

¢ Export to VTLS Format: Converts records to MARC 2709 format. Re-maps
001/035 tags to VTLS Classic format.

¢ Remember for Thank You Letter: While the record of a gift or deposit is open in
the MARC Editor, lets you append the data in the 541 tag to a file to be used in
printing Thank You Letters or acknowledgments.

e Insert Unicode Control Character: Unicode Control Characters are tags that
help with text flow and direction for languages such as Hebrew and Arabic that are
right justified.
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Understanding VTLS Locally-Defined Tags and Fixed Fields

There are three special MARC record tags defined by VTLS for use in the Virtua client and
server. Each of these special tags contains several non-USMARC fixed fields.

e 999 VIRTUA tag
999 VTLSSORT tag
e 039 tag

The 999 VIRTUA Tag

The 999 VIRTUA tag gives you a way to enter, in a 2709 format, non-MARC information
associated with a MARC record and to communicate that information to and from the
Virtua client and server. The 999 VIRTUA tag has a subfield ‘a’ whose value begins with
VIRTUA. The MARC Editor adds the tag automatically to a MARC record if it is not already
present.

The following VTLS locally defined fixed fields are stored in the 999 VIRTUA tag.
Local Level: A one-integer field that appears in all fixed-field layouts and defines the
source of the record.

0 - Directly downloaded from an online utility (such as OCLC, RLIN, etc.)

1 - Record copied from the same database or from another VTLS database
2 - Upgrade of a short record downloaded from a non-MARC-based system
4 - Created by direct manual entry

5 - Loaded from tape

Analyzed Flag:
The Analyzed Flag indicates whether the record is part of an analyzed series.

0 or blank - the record does not represent part of an analyzed series
1 - the record represents part of an analyzed series
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The 999VTLSSORT Tag

The 999 VTLSSORT tag lets you define in the MARC Editor a customized sorting of the
tags in a MARC record as it displays on the View Record, Patron Information, and Record
Previewing windows. The software normally sorts tags in numeric order, but the
VTLSSORT tag lets you sort tags in any order you wish. The data that follows VTLSSORT
consists of a series of tag number delimited with an asterisk (*). The asterisk identifies
the tag as unique to the MARC record where the VTLSSORT tag is found. The order of the
delimited tags indicates the order in which the tags display in the MARC editor.

Note: This tag cannot be modified.

For example: Re-ordering the MARC record so that the 090 tag comes before the 040
tag results in a VTLS 999SORT tag as follows:
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The 039 Tag

The VTLS locally-defined 039 tag keeps track of the history of a MARC record, which
includes the date of database entry, the name of the database entry “person,” and a
series of dates of modification and names of modifiers. The 039 tag applies to all record
formats

Note: You cannot edit the 039 tag. By default, the tag will not even appear in the MARC
Editor. When you create or modify a record, Virtua automatically creates or modifies the
039 tag. You can choose to display this tag by modifying the Tags Not to Display field
in the Cataloging Options window.

Subfields of the 039 Tag

Subfield Value Definition

a YYYYMMDDHHMM Most Recent Modification Date

b Any String Most Recent Modifier Virtua Log-in
Name

C YYYYMMDDHHMM Previous Modification Date

d Any String Previous Modifier Virtua Log-in Name

y YYYYMMDDHHMM Virtua Database Entry Date

Z Any String Virtua Database Entry Person Virtua
Log-in Name

When new records are created or loaded into the Virtua database, the added 039 tag will
include only \y and \z.

e The first time the record is edited, Virtua adds a set of \a \b (Modification Date +
Log-in Name).

e The next time the record is edited, Virtua moves \a \b to \c \d and creates a new \a
\b.

e With each modification of the record, Virtua updates and replaces the \a \b and
moves the \a \b to the most recent \c \d.

e The \c \d repeat for each previous modification for up to 4 ¢/d combinations. In this
way, the last 5 modifications of the record are stored in reverse chronological order.
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—
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Documentation and Help

Virtua Users Guides are available in searchable .pdf format from the Tools menu; click
on the Tools menu, then select Documentation Search Engine. The Documentation
Search Engine appears on your Tools menu by default, it is functional only if the Virtua
documentation has been installed via the Documentation Installer. For details on the
Documentation Search Engine, see the section Getting Help with Virtua: Viewing and
Searching the Virtua Documentation in the Virtua Client Getting Started Primer.

W Virtua - Headquarters - Customer Support Library E]@
File Search Circulation Acquisiions Cataloging Options  Tools  Window Help

@O AR €©GE A B E 00 Comeen - |BD B
Default connection: Customer Support Library - staff Notepad

On Screen Keyboard

WordPad
Documentation Search Engine ‘

The Help Menu links to detailed information about MARC 21, CATMARC, SWEMARC,
and UNIMARC Format.

W Virtua - Headquarters - Customer Support Library E]@
File Search Circulation Acquisiions Cataloging Options Tools Window  Help
1 H =" MARC21 Auth Hel L 1
WU AR eCHEH MBD N - e B |
MARC21 Bib Help L
Default connection: Customer Suppart Library - staff Current connection: CustiERE e bR = 1y a s

MARCZ21 Community Info Help
Patron MARC Help

CATMARC Help
CATMARC Leader 06 Help
UMIMARC Bib Help
UMIMARC Auth Help

Permissions Help
About...
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Select the type of help you wish to access. The Concise Format Data window will
appear for the format you selected

For example: When MARC21 Bib Help is chosen from the Help menu, the Marc 21
Concise Format for Bibliographic Data will appear.

€ MARC 21 Concise Format for Bibliographic Data (=[]
File Edit Bookmark Options Help

Eontents| Index | | Frint | << | 3 |

Contents

mE

Disclaimer: This help file represents to the best of our knowledge the MARC 21 Concise Format for
Bibliographic Data as published by the Library of Congress atthe time this software was released. For
the most current wersion of all MARC standards as well as information about updates and changes,

wisit the Library of Congress Wehbsite: hitp/fwww |oc.govimarcy,

Introduction to the MARC 21 Concise Format for Bibliographic Data

Leader and Directory

Leader
Directony

Control Fields

Introduction to Contral Fields

001 Control Mumber (ME)

003 Control Murmber Identifier (ME)

005 Date and Tirme of Last Transaction (NE)

006 Fixed-length Data Elements—Additional Material Characteristice—General Information (F)
007 Physical Description Fixed Field—General Information (F)

008 Fixed-length Data Elements—General Information (ME)

Wariable Fields:

Murnber and Code Fields {01x-04x)

Classification and Call Nurmber Fields (05x-09)

bdain Entry Fields (1304

Title and Title-Felated Fialds (20024

Edition, Imprint, etc. Fields (25x-28x)

Fhysical Description, etc. Fields (=)

Series Statement Fields (4]

Mote Fields (Part 1: 50+-535)

Mote Fields (Part 2: 536-58)

Subject Access Fields (B

Added Entry Fields (7 0x-75x) b |
Linking Entry Fields (7Ex-78x) [l

Note: The information appears in tag number order.

Select a topic by clicking on the desired link within the Concise Format Data window;
the topic will be brought up in the concise format data window.

Advanced Cataloging Workflow-Based Reference Guide Last Revised: Oct 2017
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€ MARC 21 Concise Format for Bibliographic Data |- ||0) 53

File Edit Bookmark Options Help

Eu:untents| Index | Back | Erint | €4 | xr |

Main Entry Fields (1>CX)

main entry in bibliographic records. Except for the definitions of
indicator positions and subfield codes that are field specific, the

consistent for Main Entry (100-130), Series Staterment (400-4907,
Subject Access (B00-630), Added Entry (700-730), and Series
Added Entry (B00-830) fields.

100 - kain Entrv—Fersonal Mame (ME)
110 - bdain Entre—Corporate Mame (ME)
111 - kain Entry—tdesting Mame (ME)
130 - bdain Entry—UInitorm Title (HE)

Fields 100-130 contain & name or a uniform tite heading used as a

content designation for each type of name and far uniform titles is

15

Click on the Index tab to use the index feature. The index feature is used to search a

list, in tag number order, of all tags associated with that particular type of MARC
record. When the Index feature is selected, the Help Topics window appears.

Help Topics: MARC 21 Concise Format for Bibliographic Data

Cortents  Index ]Flnd ]

1 Type the first few letters of the word you're looking for.

2 Click the index entry you want, and then click Display.

$5 - Institution to which Field &pplies ~
$6 - Linkage —
$8 - Field Link and Sequence Mumber

0071 - Control Number

003 - Control Mumber 1dentifier

005 - Date and Time of Last Transaction

00E - Books

006 - Computer Files/Electionic Resources

00E - Continuing R egources

(006 - Fixed{ength D ata Elements--Additional M aterial Characteristics--G
10E - Mapz

00E - Mized Materialz

006 - Muszic

00E - Yizual M aterialz

007 - Electionic Resource

007 - Globe -
007 - Kit ]

Display | | Cancel ‘

Click on the Find tab to search by keyword.
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Feature specific help is available; from the window for which additional information

about a feature is wanted, using the F1 key or right mouse click will bring forward more
information regarding that portion of the window.

(W\"lrtua—ﬂendquarlaers—tustmr Support Library um
File Search Crodation Acquisions Cataloging Options Tools Window Help
@i 4 & Lo hBERIN — QOR &k Inmplus

€ What's This? M= x|
l |

The MARC tab displavs the complate contents of the MARC record in
the MARC view, dsplaying all tags, subfields, and indicators.,

%

The Window Menu tracks the order in which open Virtua windows were accessed.

WA

W Virtua - Headquarters - Customer Support Library u@-
File Edit Search MARC Editor Circulation Acquisiions Cataloging Options Tools | Window Help |

W @V 4% ¢eo@ MBE [N QLT o=

Close all Messages
Cascade Cataloging Windows
Tile Cataloging Windows

Default connection: Customer Support Library - staff Current connection: Customer Suppd

1 MARC Editor - Customer Support Library
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Cataloging Workforms

Recommended
Workflow Explanation
: Virtua provides a user-friendly interface for cataloging
Configure material based on cataloging workforms.
Cataloging
Options To help you create new records, Virtua provides preset
workforms for Bibliographic, Authority, Holdings, and
Community Information MARC formats; Patron; and circ-
v on-the-fly records. These may be modified to suit your
Use needs.
Workforms
e The workforms are located at C:/Program
v Files/VTLS/Virtua/Catalog/
e The workforms can be identified by the file
Reii?g‘;hby extension *.wfm.
Record State e Most workforms are available in two versions, one
without subfield codes labeled and one with labels.

A

Use Duplicate
Checking

Summary

Edit an existing workform
Create a new workform
Save workforms

Merge a workform with a record

Key Terms

MARC Editor
MARC Indicator
MARC Tag
Workform
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Workforms

Click on the Add New Record icon on the Cataloging Toolbar or select File >
Records - Create Record. The Create Record window appears.

-~

Create Record
Laok in: | (=3 Catalog - £ E-

I Mappings 110aulab .wfm circFly wfm fi
I Mew Fixed Field Files acq.wim carnm.wEm Fi
|5 M Workfarmns analytica,wfm commlab wfm q
[ MSSaW analytich,wfm comp.wim lu|
| validate bk, wfrm complab, wimm lu|
110au.wfm boolklab.wfm Frbrexpr.wkm il g
< >
File name: b
Files af bype: | I ser workforms [.wfrn) j Cancel |

Note: The directory displayed will default to the last directory viewed from within Virtua
Client.

Select a workform and click Open. The MARC Editor will appear with the workform

loaded.

Create Record
Lack jr | (3 Catalog - i gl EEE

I iMappings 110aulab,wfm circFly wfm Fi
I Mew Fixed Field Files acg.wfm carnm, wim fi
I Mew Warkforms analytica, wim cornmlab, wfr gd
[CaMSsAW comp. wim q
|y validate i | caornplab. whm q
110au. wfm 58| booklab, wim frovespr. wkm qd
< >
File narne: |I:u:u:|k
File= af ype: | Uler work formns [ wimn) j Cancel
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Edit a Workform

Click the Edit Workform icon or on the Cataloging toolbar or select File 2>
Workforms 2> Edit Workform on the Virtua menu bar.

-
| —
(W Virtua - Headquarters - Customer Support Library E]@
File Search Circulation Acquisiions Cataloging Options Tools Window Help
Cose Connecton... B &a%E N < 9FAZ & |20 e s
Mew Connection...
Connection List, .. 111l Current connection: Customer Support Library - staff v
Records 3
Workforms 2 Edit Workform...
Delete Waorkform. ..

Print Thank You Letters...
Clear Thank You Information

Printer Setup
Receipt Printer Setup

Exit Alt+¥

The Edit Workform window appears.

-,

"Edit Workform

Loak. in: I I Catalog j = £F EH-
IZ)Mappings 110aulab whm circFly wfm fi
I3 Mews Fixed Field Files acg.wfm o, fi
I Mew WarkForms analytica,wfm commilab . wfm EI lul
IS saw analvtich _I:-\IFm comp.wfm lul
I validate =ho carnplab, q
110au.wfrm = Frbrespr wfrn qd
(<] 1 | (*]

File name: Ibl:u:uk Open I
Filez of type: |W-:urkh:-rm Files [*.wfrm] ;I Cancel |

Select the workform to edit. Click Open; the MARC Editor window appears.
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Edit the Workform by adding or deleting tags from the right mouse click pop-up menu.

24 MARC Editor - Customer Support Library g@
|

[] | oooooo 000 0 eng d
[ 1[ow J[ ][]
[ 1[o20 J[ ][]

i
[]
[]

nda Ctrl+Z

Insert Unicode Control Character »

Print... Ctrl+P
Save...

000000060
F00000000
IRRRRRRRRAND

[=}]
i
=]

NN
o

E-mail. ..

Add Tag... Shift+Ctrl+4
Copy Tag Shift+HCtrl+C

||:a]| Language material

=| = MARC 21 Bib:
‘"book_wfm / Create Authority Record(s)...

Save the workform.
Select File > Save to save the workform with its existing name.

Select File &> Save As to save the workform with a different name.
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Delete an Existing Workform

Select File > Workform > Delete Workform.

(W Virtua - Headquarters - Customer Support Library

-\
=23
File Search Circulation Acquisiions Cataloging Options Tools Window Help

B 4% Nl - |90  |ep ol

Close Connection...
Mew Connection...

Connection List, .. Gir- 1 Current connection: Customer Support Library - staff 2
Records 4
Waorkforms ¥ Edit Workform. ..

Delete Workform. ..

Print Thank You Letters. ..
Clear Thank You Information

Printer Setup
Receipt Printer Setup

Exit Alt+¥

The Delete Workform dialog box appears.

-

Delete Workform @
Look jr; | [ Catalag x| - £ Ef-

[C)Mappings 110aulab, wkm circfly wfm fi
I Mew Fixed Field Files aca,wkm carnmm, i fi
[CaMew wWorkforms analytica,wfm commlab, wkm EI g
[C2IMssaw =B . =] comp. wm =
ICyvalidate e | complab.wim q
110au.wfm ] booklab . wim Frbrespr.wkm g
(<] 1 | 2]
File name: |b.:u:.k Open I
Files of type: ILIser Workforms [ wim) ﬂ Cancel |

Select the workform to delete; the Confirm deletion box will appear.

Click Yes to delete the workform.
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Specialty Workforms

Brief MARC Records to Circulate Non-Cataloged Material

You may create brief bibliographic records to circulate material that has not yet been
added to the database. This is called circ-on-the fly. Your library designates a special
workform for the purpose of creating circ-on-the-fly records. Virtua Cataloging provides a
workform called circfly.wfm.

To create a brief bibliographic record using circ-on-the-fly:
Follow the steps to create a new MARC record.

Choose the workform designated by your library as the one to use for circulating
material on the fly. Virtua has a circ-on-the-fly workform that you may select from
Circulation = Transactions > Circfly.

Brief MARC Records to Circulate Non-Library-Owned Material

You may want to create brief bibliographic records to circulate material that is not owned
by your library. An example of such material is a book or article owned by a professor who
wants to place it on reserve in the library.

Virtua does not supply a workform for this, but you can create a special workform to be
used for these brief records. The Circ-on-the-fly workform has the briefest entries and is a
good place to start.

To create a brief bibliographic record for non-library-owned material:
Follow the steps to create a new MARC record.

Choose the workform designated by your library as the one to use for non-library-
owned material. This may be the circ-on-the-fly workform or one designed by your
library.

Patron Workform

Virtua provides a default patron workform, patron.wfm, which you can use or modify to
create patron records. If you modify the default patron workform, you can save the
workform under the same name or a different name. The installation programs for Virtua
releases will not overwrite any *.wfm files that already exist.
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*Updated to 16.1



Merging Workforms with MARC Records

24

When a number of new tags need to be added to an existing MARC record, Virtua offers a
workform merge feature. Instead of adding individual tags to the record, you can merge a

workform into the record to add tags and subfield data contained in the workform but

missing in the record.

To add tags to a MARC record via a workform merge:

In the MARC Editor, open the bibliographic record to which you want to add tags.

In the menu bar, click the MARC Editor, and then choose Merge Record with

Workform.

W Virtua - Headquarters - Customer Support Library E]@

7@ = U

Default connection: ¢

Create Autharity Record(s)...

Duplicate Record in Mew Window
Merge Record with Workform. ..
Card Screen Preview...

Export to VTLS Format...

Remember for Thank You Letter
Insert Unicode Control Character »

File Edit Search | MARC Editor Circulation Acquisitons Cataloging Options Tools Window Help

g ||N| - QFZ & «  BDLhB

1t connection: Customer Support Library - staff

|9?D‘33Ds 1997 nyu 000 1eng
[ \a 97-4378

[\a 0380973812
[\wDLc\cDlc oL

|
|
|
|
[\ nus— |
[\a513/.542 21 |
| \a F 2 BRADBURY |
|
|
|
|
|
|

| \a Bradbury, Ray, \d 1920-

245 1|0 | ‘a Driving blind / \c Ray Bradbury.
I:I l:l l:l | \a 1st ed.
|:| |:| |:| [ & Mew vork : \b Avon Books, \c £1937.
I:ll:”:l |'|,3261|:|.;'|,|:22cm.
[] [ ][] [emarciveo3joijos
I:I l:l El ‘a United States '« Sodial life and customs \y 20th century
\w Fiction.
[] [0][o] [\BraDBELIZG000 |
|(a]| Language material Ll {m) Monograph/Ttem j [ Masked
ﬂ MARC 21 Bib: Book OPAC
"OPACT §
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If a default workform has been specified via the Cataloging Options function, the
merge will begin automatically.

If no default workform has been specified, the Select Workform to Merge dialog
box will appear).

Select a workform and click the Open button. The merge will begin.

-

Select Workform to Merge @
Lack in: | (=3 Catalog - =k EH-
) Mappings 110aulab,wfm circFly i fi
|2 Mew Fixed Field Files acd.wim carnr.wEn Fi
I Mew WorkForms analytica.wfm commlab . wfm q
(Dmssaw [ analytich wfm (= comp.wfm g
) validate ;fll:unnkwfm complab, wim lu|
110au.wfm 551 booklab, wim Frbrexpr. whm |
< 21
Files of tupe: | I zer workforms [ wim) j Carncel |

The merge function will:

e Overwrite the bib level of the record with the bib level of the workform.
e Add tags and subfield data contained in the workform but missing in the record.
e Not overwrite or change any data already in the record.

After the merge is complete, Virtua displays the inserted tags and subfields in the MARC
Editor window. The MARC record will scroll to the first added or modified tag.
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Setting Cataloging Options

Recommended
Workflow Explanation
: The Cataloging Options window offers numerous options
CC:tr;?oggui;eg for customizing your cataloging session. There are seven
Options tabs, each containing options that may be set.
e File Options
v e Workforms
File Obti e Display Options
e Lptions e Copy Options
e Editor Keystroke Mappings
e Label printing
v e Other Options
8;‘?(')?1‘; Virtua allows you to select from a wide variety of
options, from choosing a default workform, selecting a

y

Copy Options

Keystroke
Mappings

A

y

Op

Other

tions

subfield delimiter, and specifying tags not to be
displayed or copied, to determining the type of record
validation you want the system to perform.

Summary

Set File Options

Set Display Options

Set Copy Options

Set Keystroke Mappings
Set Other Options

Key Terms

Cataloging Options
MARC Editor
MARC Indicator
MARC Tag
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Cataloging Options Window

28

To choose options for your cataloging session, on the Virtua menu bar select Options 2>

Cataloging Options.

W Virtua - Headquarters - Customer Support Library

BEX

File Search Circulation Acquisiions Cataloging Options Tools Window Help

W @EU | £ | €S E|a OPAcDsey
Language

Fant

Hyperlink Options...
Directionality

Default connection: Customer Support Library - staff

Change Location. ..

Circulation Options
v Sort Patron Account by Location
Cataloging Options...
Label Editor...
Load Options...
Available Languages. ..

Toolbars

% . BDBE S

The Cataloging Options window appears with the File Options tab displaying. Click on

the tabs to display other options.

W Cataloging Options - Phoenix99 E]

l Wiorkforms | Dizplay Optiuns] Copy Options 4| #

Destination for Sawved Copies rec:
CAProgram FilesWTLSWirtua2o09 4 MCatalogh (=

[ Retain 999 WTLSSORT Tag in Local Record Files
[ Retain 993 VIRTUA Tag in Local Record Files
[ Retain LCCN Hyphen in Local MARC 21 Record File:

SawelExport to File Destination Character Set:

UTF-& |
r
[ Copy Cataloging - Convert authority bib levels

Ok | Cancel
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When you are finished choosing your options, click OK. The options you set will remain in
force even after you log off the client and log back in.

Note: Cataloging Options under each tab are discussed in detail in the following

sections.

File Options

W Cataloging Options - Phoenix99 E]

=,

Destination for Sawved Copies rec:

File Options l'u‘tfnﬁd‘or‘ms Dizplay Optic.ns] Copy Options 4 |k

UTF5 j

-

CAProgram FiIes'l.WLS'I.\-"lrtuaEDDE.4.2'I.Catalng'll =

[ Retain 993 WTLSSORT Tag in Local Record Files
[ Retain 999 WIRTLA Tag in Local Record Files
| Retain LCCH Hyphen in Local MARC 21 Record File:

SawvelExpart to File Destination Character Set:

[ Copy Cataloging - Convert authority bib levels

Ok | Cancel

Label Description
Destination for Click the folder icon to the right of the Destination for
SavedCopies.rec SavedCopies.rec field, and select a location for the

Retain locally-
defined 999
VTLSSORT Tag in
Local Record Files

SavedCopies.rec file. SavedCopies.rec is the local file to
which Virtua saves records when you choose to Save Copy to
Database. The Destination for SavedCopies.rec is the location
that will be opened when you click on the
OpenSavedCopies.rec button on the Cataloging toolbar.

The 999 VTLSSORT tag lets you define in the MARC Editor a
customized sorting of the tags in a MARC record as it displays
on the View Record, Patron Information, and Record
Previewing windows.
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Retain locally-
defined 999 VIRTUA
Tag in Local Record
Files

Retain LCCN hyphens
in local MARC 21
Record Files

Save/Export to File
Destination
Character Set

Copy Cataloging -
Convert authority bib
levels

Advanced Cataloging Workflow-Based Reference Guide

*Updated to 16.1

The 999 VIRTUA tag gives you a way to enter, in a 2709
format, non-MARC information associated with a MARC record
and to communicate that information to and from the Virtua
client and server.

The MARC 21 format specifies that LCCN’s do not have
hyphens. However, Virtua puts hyphens into 010 tag data
when records are imported, so we give you the option of
removing them when you save the record to a local file. If
you choose NOT to retain the hyphens, the system removes
the first hyphen only and pads to six digits the serial number
between the hyphen and the supplemental nhumber with
zeros.

Allows you to select from multiple character sets.

Note: This option works in conjunction with the Save
functions on the File drop-down menu and Export to VTLS
format function on the MARC Editor drop-down menu. The
default is UTF-8. If you choose a character set other than the
default, when you save a record in the MARC Editor, the
system converts the record to the specified character set.

Select the '‘Copy Cataloging — Convert Authority bib levels’
check box to convert authority records from a version 46 and
higher Virtua database to records that can be saved to a pre-
46 database.
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Workforms

-,

W Cataloging Options - Phoenix99

Wiarkfarms lDispIay Options | Copy Optiohs | Editor Keyst 4 | #

Default Workform:
|C:1ngram FilesWTLE3WIMWa201 0. v atalogibook

Default Other Workdform:
|C:'I.Pr1:|gram Files™WTLSWirtua2010.1 3 1\Catalogl (=

Default Motes Wiorkform:
|C:'I.Pr1:|gram Files™WTLS201 0.1 \Cataloginotelab wfm - (=

Defaut Holdings Warkfarm:
|C:'I.Pr1:|gram Files™WTLS201 0.1 3\Catalogiholds wim - (=

| =1

Ok Cancel
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Label

Description

Default Workform

Click the folder icon to the right of the
Default Workform field, and select
from the Select Default Workform
dialog box. When you use the Create
Record function, this workform will
appear in the MARC Editor
automatically.

Default Other Workform

Click the folder icon to the right of the
Default Other Workform field, and
select from the Select Default
Workform dialog box. When you use
the Create Other Record function, this
workform will appear in the MARC
Editor automatically.

Default Notes Workform

Click the folder icon to the right of the
Default Notes Workform field, and
select from the Select Default
Workform dialog box. Virtua supplies
a predefined notes workform
(notelab.wfm) to be used

to create copy-specific notes. When
you create a new copy-specific notes
record for a holdings or item record,
this workform will appear in the
MARC Editor automatically.

Default Holdings Workform

Click the folder icon to the right of the
Default Holdings Workform field, and
select a workform from the Select
Default Workform dialog box. Virtua
supplies a predefined workform
(holds.wfm) to be used to create
holdings records. When you create a
new holdings record from the View
Bibliographic Record window, this
workform (or another that you have
customized) will appear in the MARC
Editor automatically.
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Default Child Workform Click the folder icon to the right of the
Default Child Workform field, and
select a workform from the Select
Default Workform dialog box. When
you use the Create Child Record
function to create a new record, this
workform will appear in the MARC
Editor automatically.

Note: This functionality is used for
Virtua Archives Management
customers.

Display Options

On the Display Options tab, you can set options that are related to the display of
records or workforms in the MARC Editor.

W Cataloging Options - Phoenix99 E]
Workforms  Display Options lCDp'_-.r -::upti-:.ns] Editor Keyst 4 | P
MAE{C Label=s
[ Max. Label Extent:

-
Label Source File:

CAProgram FilesWTLSWiMuad49_ 3 McCatalogd (=

Y

Subfield Delimiter: Mon-SortingdFiling Markers
(O & | (" fandl

Tags not to Dizplay or Add:

v lghore WTLSSORT Tag
v Dizplay 850 tagiz) after linked tag

Ok | Cancel
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Label

Description

Use MARC labels

Subfield Delimiter

Non-
Sorting/Filing
Marker

Tags Not to
Display

Ignore VTLSSORT
Tag

Display 880
tag(s) after
linked tag

Advanced Cataloging Workflow-Based Reference Guide
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Select or de-select Use MARC Labels as the editing mode for the
MARC Editor. If you choose to Use MARC Labels, you can then
select the following:

e Whether you want the labels to appear above (vertically)
or beside (horizontally) the data field in the MARC Editor.

e The percentage of the screen used for labels in horizontal
format.

e The path to the source file for the labels. The default file is
labels.rec.

Choose the Subfield Delimiter you want to display in the MARC
Editor. In the United States, the backslash (\) is usually used.

Choose the Marker that you want to use in the MARC Editor.
Non-sorting/filing markers function like the non-filing indicator.
The MARC Editor displays the beginning and ending markers as
either vertical bars, The |Great Gatsby, or as wavy brackets,
The }Great Gatsby.

In the Tags Not to Display box, type any tags you do NOT want
to appear or be edited in the MARC Editor or, if a list of tags
already exists, delete any tags you do want to appear in the
MARC Editor.

If this option is checked, tags in the MARC Editor will display in
numerical order. If this option is unchecked, the VTLSSORT tag
will determine the order in which tags display.

Enable this if you want 880 tags to display directly after the
linked tag. If left unchecked, they will display in numeric order.
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Copy Options

W Cataloging Options - Phoeni@9 @
Copy Options | Editor Keystroke Mappings | Label Printing | cilr
Tags not to Copy into Mew Editor Window:

001035

Subfields not to Copy into Mew Editor Window:
|020z

Data not to Copy into Mew Editor Window:
|245¢

[ Automatically add default library symbol when copying
from union. (See Other Options)

For copy cataloging, do not send the 001/003 tags from
source records with the following 003 values:

Ok | Cancel
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Label

Description

Tags not to Copy
into New Editor
Window

Subfields not to
Copy into New
Editor Window

Data not to Copy
into New Editor
Window

Automatically add
default library
symbol when
copying from
union

For copy
cataloging, do not
send the 001/003
tags from source
records with the
following 003
values

Tags will not be duplicated when the record is copied. The 001
tag (Control #) must display in this window or the original
record will be overwritten.

When a record is duplicated in the MARC Editor, this option
will not copy either the information in these tags or the tag
themselves.

Enter the information into the text box with the tag number
followed immediately by the subfield. Use a space to separate
tags. If multiple subfields are desired for the same tag add the
subfield letters next to each other.

Example: 020z 245dh

When a record is duplicated in the MARC Editor, this option
will remove any data in these fields but will copy empty tags
and subfields.

Enter the information into the text box with the tag number
followed immediately by the subfield. Use a space to separate
tags. If multiple subfield are desired for the same tag add the
subfield letters next to each other.

Example: 541abgh 978a

Virtua will automatically insert the default library symbol in
records copied from a union catalog. The check box will be
active only if a library symbol is typed in the Default Library
Symbol field on the Other Options tab. Note that Virtua
prevents the deletion of a bibliographic record that contains a
library symbol.

When this field is populated, Virtua will save the copies of the
records without the original 001 and 003 tags. Virtua instead
will add new 001 and 003 tags, and will hot generate a new
035 tag.

Note: Virtua also has the ability to specify tags and/or subfields to be deleted from
incoming records based on the source of record (value in 003 tag). This is a value defined
in the Profiler and will apply to ALL incoming records from that source.
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Editor Keystroke Mapping

Virtua provides the ability to create keyboard shortcuts for commonly used phrases or
diacritics. These shortcuts are created in the Cataloging Options window, Editor
Keystroke Mappings tab, and are available in the MARC Editor window when creating

or editing MARC records.

To create a keyboard shortcut, click on the Editor Keystroke Mapping tab of the
Cataloging Options window.

W Cataloging Options - Phoenix@9 @

Editor Keystroke Mappings |La|:|EI Printing | Other Opﬁu:uns] il

Shortcut | Text |

Add

O Cancel

Click the Add button. The Add New Editor Shortcut window will appear.
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7 hdd New Editor Shortcut - Ph... = )| &3 |

Shortout:

Please enter the keystrokes for the new shorcut in the
Shortcut edit area. Your keystrokes will be displayed as
lest. Then enter the sthing inthe Text area.

|ﬂ-.|t+8

Text:

Cortents;

Ok

Cancel

38

In the Shortcut textbox, enter the keystrokes for the keyboard shortcut. The keystrokes
will appear in the Shortcut textbox.

In the Text textbox, enter the corresponding text for the keyboard shortcut.

Hit the Enter key. The Add New Editor Shortcut window will close and the shortcut

with the corresponding text will appear in two columns on the Editor Keystroke

Mappings tab.

f Cataloging Options - Phoenix@d

=

{ Editor Keystroke Mappings | Label Printing | Other Options ] il

Shortout

|TExt

Shift+Ctrl +H

g7

Add

Delete

oK | Cancel
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In the MARC Editor, place your cursor in the tag where you wish to enter the text.

Perform the keyboard shortcut. The associated text will appear

Label Printing

The Virtua Client lets you create printable files of spine labels, CD inserts and patron
address labels from Saved Lists created in Chamo. Templates to be used for the label
creation must be specified on the Label Printing tab of Cataloging Options in order for
the labels to be created.

A separate template may be used for each type of label.

fw Cataloging Options - clay68 -\

Editor Keystroke Mappings  Label Printing l{}ther Opticns 4 | »

Spine Label Template:
Patron Label Template:
CD Inzert Template:

Property Label Template:

L A A

Heldings Spine Label Subfiekds
|h,i

Hokdings Spine Label Template:

| =
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Label Description
Spine Label Displays the name and location of the template to be used for
Template printing spine labels. If you do not specify a file, Virtua will

Patron Label
Template

CD/Insert Template

Property Label
Template

Holdings Spine
Label Subfields

Holdings Spine
Label Template

use the default template labinput.txt in the Virtua directory.

Displays the name and location of the template to be used for
printing patron address labels from Saved Lists. Virtua does
not come with a default template.

Displays the name and location of the template to be used for
printing CD inserts from Saved Lists. Virtua does not come
with a default template.

Displays the name and location of a template for printing
property labels. If you do not specify a file, Virtua will use the
default file proplabinput.txt in the Virtua directory.

Allows you to define which subfields of the 852 tag Virtua will
use when finding a call number to print on a spine label. This
list is comma-delimited, and the default values are ‘h’ and 'i’.

Displays the name and location of a template for printing
holdings spine labels. If you do not specify a file, Virtua will
use the default file holdlabinput.txt in the Virtua directory.
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Other Options

A

W/ Cataloging Options - clayé8

Label Printing Other Options |

Validation Opticns
v Validate when Saving to File
|v Validate when Saving to Database

[¥ Use Specific Bibiographic Rule Fies

[+ Show Delete Warnings

[+ Print request siip for new

[~ Mask New Records
[+ Edit 006, 007, 008 in Editor [~ Use Multiple Editors
[T Overamte Varable Fiekds | Use Patron Editor

x|
bl

Analytic Record Control
Number Source Tag

{* 001 {035

trapped items
Bibicgraphic MARC Format Drefault Library Symbol
|MaRC 21 =l
Email Reply To Address Email From Address:
XML Editor:

! e
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Label

Description

Validation Options

Show Delete
Warnings

MASK New Records

Edit 008 in MARC
Editor

Use Multiple MARC
Editors

Overwrite Variable
Fields

Use Patron Editor

Print Request Slip
for Newly Trapped
Items

Bibliographic MARC
Format

Advanced Cataloging Workflow-Based Reference Guide
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Check the box which represents the desired validation
workflow.

You can choose whether or not to display a warning when you
delete tags.

If checked, all new records will be masked.

If checked, clicking once in the 008 tag of the MARC record
will allow you to directly edit the 008 tag in the MARC Editor.
The bottom of the MARC Editor will display the number and
value of the tag where the cursor is positioned. If this option
is not selected, the 008 tag will open in a Fixed Field Editor
window for editing.

If checked, each MARC record is opened in a new MARC
Editor window.

Allows you to determine whether variable field data is
automatically selected in the MARC Editor so it can be
immediately overwritten by your next keystrokes.

If checked, the Patron Editor interface will be used for
creating/editing patron records.

Profiler Tip: The Patron Cataloging Options parameter
contains options that let you customize various aspects of
patron cataloging and the Patron Editor window in the Virtua
client. See Configuring Patron Cataloging Options in the Virtua
Profiler: Cataloging Parameters User’s Guide for more
information.

If checked, Virtua will print a request slip when an item that
can be used to satisfy an outstanding request is added to a
bibliographic record. For this to work, the Do Not Trap New
Items option in the Virtua Profiler must be disabled.

Allows you select the bibliographic MARC format for new
records that are created. Most typically used when a database
allows multiple MARC formats.

Profiler Tip: The MARC Format Options consist of three
settings. MARC Format, MARC Auth Format, and MARC 21
Format. The MARC Format setting lets you specify the format
of the MARC records in your database. Important: This
parameter is to be set ONE time only. Do NOT change the
value of this parameter once you have set it. See Setting the
Cataloging Basic Options Parameter: About the MARC Format
Options Setting in the Virtua Profiler: Cataloging Parameters
User’s Guide for more information.
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Default Library
Symbol

Email Reply To
Address

Email From Address

XML Editor

Analytic Record

Control Number
Source Tag

For union catalog users, specifies the default library symbol
that you want Virtua to add to a newly created bibliographic
record. Note that Virtua prevents the deletion of a
bibliographic record if it contains a library symbol.

Profiler Tip: Via the Library Members parameter, union
catalogs can define a name and symbol for each member
library and specify the bibliographic tag into which the symbol
should be inserted. See Working with the Library Members
Parameter in the Virtua Profiler: Global Settings User’s Guide
for more information.

If the database uses the server to send Client emails, users
must specify a Reply To email address here in order for those
emails to be sent from the Client.

Profiler Tip: The E-mail Configuration parameter allows you
choose whether e-mails sent via the Virtua client are sent
through the default e-mail client software on the workstation
or through the Virtua server software. See Working with the
E-Mail Configuration Parameter in the Virtua Profiler: Global
Settings User’s Guide for more information.

Allows you to configure an e-mail address to use as the From
address for e-mails sent from the Virtua client.

Allows you specify the local location of a third-party XML
editing program to use to edit XML records. This means that
you will be able to view and edit the XML records from the
View Bibliographic Record window.

Allows you to specify whether the 001 or 035 of the parent
bibliographic record is used for the 773 tag subfield $w when
creating an analytic record from a bibliographic record.
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Load Options

Recommended
Outline Explanation
Configure Virtua provides the ability in the client to specify options

Load Options

Define
Duplicate
Tests

Define Merge
Rules

Define State

Load Records

for saving records either to the database using the
Import Tool or by editing local records in the MARC
Editor and then saving the records to the database.

Summary

Configure Load Options

Configure Duplicate Tests

Configure Merge Rules

Load records using the Import Tool
Load records using Edit local records

Key Terms

e Duplicate tests
Merge Record
Merge Rules
Database actions
Record State

Profiler Parameter
e Heading Replacement Flag
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Configure Load Options

The Load Options window allows you to set a wide variety of options for loading records
into the Virtua database. The Load Options window contains five tabs:

General

Bibliographic and Community Information
Authority

Holdings

Patron

Record-Loading Logging

When records are loaded via the Virtua client, the logs will contain the following
information:

Number of Records Processed

Number of Records Successfully Saved to/Validated in DB

Number of Records Failed by Vericat

Number of Records Not Saved to/Not Valid according to DB

Number of Saved/Validated Records without Diagnostics

Number of not rejected (warning flagged) records

Bib IDs of successfully imported records

Bib IDs of records put into Error state

Bib IDs of records being imported that were found in the database
Warning messages about missing headings or newly created headings

Local Load Options File Option

The Save to File... button and Local Options File field are on the following tabs only:
Bibliographic, Authority, Holdings, and Patron.

The Save to File... button allows you to save to the local PC options configured for a
specific record type plus the options configured on the General tab (except for the Load
Options File option). To import the records via the Virtua client use the Local Options
File field.

After a Local Options File is created it may be edited with a text editor to add
command-line load options that are normally available for use with vload.exe (see the
Virtua Record Loading User’s Guide for a description of command-line options available
with vload.exe).

[+ Local Options File: | (=
Save To File...
Advanced Cataloging Workflow-Based Reference Guide Last Revised: Oct 2017
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General Tab

Select Options - Load Options from the Virtua Main menu. The General tab is the
default tab. Options set on this tab will affect ALL records, regardless of format.

Load Options - phoenix

General | Bibliographic (and Community Info) ] Authority ] Holdings ] Patron ]

v aLa =]
[+ Date Entered Flag: |Assign Today as Entered Date ﬂ
[~ Load Options File: |

¥ Record State: |Pr0cess immediately ﬂ

OK | Cancel |

Click the check box to enable desired features and select an option from the drop-
down list if necessary.
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Feature Purpose
Character Allows you specify the character set of the incoming
Set record(s). By default, the system converts the data in
each loaded record to the UTF-8 character set. The
default character set load option is “*no mapping.” You do
not have to specify “no mapping” if you are loading
records that are already in the UTF-8 character set.
If your records are NOT in UTF-8, you need to specify the
appropriate character set option so that the character set
will be mapped correctly. You can choose from the
following character sets:
e UTF-8 (no mapping is necessary)
e MARC 21
e ANSI extended for UCL + ANSI 8 + ANSI Z39.47
e EUROPA 3
e Windows Latinl
e PC-8
e Windows ALA
e Windows Arabic
e Windows Hebrew
e Windows Cyrillic
e Windows Latin 2
e ISO 6937/2
e Microsoft CP 850
e ISO 6937/2 + Arabic
e Greek
e Big5 (the variant used by Tamkang University)
e Big5 (HKSCS)
e ANSI-8 + Hebrew
e UTF-8 character sets in which some separate
diacritics need to be combined.
e Swiss ANSIS
e GBK
e TIS620 Classic Thai
Date Allows you specify which of two dates to use as the
Entered Flag | Entered Date for the record(s).
Load Allows you type the name of a file, which is saved on the
Options File | server that contains preset options.
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Record State | Allows you choose the record state, as defined by your
library in the Cataloging Record States parameter, to
which you want to save the incoming records.

Profiler Tip: The Record States parameter lets you
define record states, edit or delete the default states, and
define additional states. See Configuring Record States in
the Virtua Profiler: Cataloging Parameters User’s Guide
for more information.

Bibliographic Tab
Click the Bibliographic tab. Options set on this tab will affect only bibliographic and
community information records.

Load Options - phoenix
General Bibliographic (and Community Infa) ] Autherity | Holdings | Patron |
[ Database Action: |Load Item Bib Parent ﬂ
| Create Items: |Pr0cess data in item tags regardless of location ﬂ
[~ Require Virtua 949 Label
[~ Shelf Location:
[~ Item Class:
|v Duplicate Tests:
Add Edit Delete
| Merges:
Add | Edit Delete
[v Mon-Dupl. Action: |DD not save non-duplicate incoming records. ﬂ
| Split FRER
[¥ Load Options File: |
[v validation: |1|'alidate and save ﬂ
[~ Mave 880 tag data to associated tags
| =l
Save To File...
oK | Cancel |

Click the check box to enable desired features and select an option from the drop-
down list if necessary.
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49

Purpose

Database Action

Create Items

Virtua 949 Label

Shelf Location
Item Class

Duplicate Tests

Merges
Non-Duplicate
Action

FRBR Splitting

Validate Only

Advanced Cataloging Workflow-Based Reference Guide
*Updated to 16.1

Allows you tell the software which action to take -
load items and parent records OR create items only -
against a file of bibliographic records.

Allows you specify the rules by which item records
are created from information in the 949 VIRTAITEM
tag of the incoming parent bibliographic records.

Allows you specify whether or not a Virtua Label is
needed in the 949 tag subfield \a. See Virtua 949
Labels section for further details.

Allows you specify a shelf location for loaded items.
Allows you specify the item class for loaded items.

Allows you specify duplicate tests for incoming
records based on particular tags. The software can
perform duplicate checking on the 001, 010, 015,
020, 022, 024, 028, and 035 tags of bibliographic
records.

Allows you create rules for merging incoming records
with existing records when duplicate records are
created.

Allows you specify which action to take against
incoming records that are NOT duplicates of records
in the database

Allows you specify to split records into work,
expression, and manifestation (FRBR standard) or not
to use the FRBR standard.

Allows you specify whether incoming bibliographic
records are both validated with and saved to the
database or only validated.

Profiler Tip: The Record Validation Rules parameter
lets you determine the action that is triggered
whenever a validation rule is applied to an incoming
record by the server. Note that in this parameter you
CANNOT add or delete rules, change the ID of any
rule, or modify the description of any rule. See
Configuring Record Validation Rules in the Virtua
Profiler: Cataloging Parameters User’s Guide for more
information.
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Move 880 Tag If the record contains 880 fields, the data in the 880
Data to fields will be moved to replace equivalent data in
Associated Tags | those associated tags listed in the linking fields. The

For the Duplicate Tests and Merges features Additional windows open when you click

the Add button.

Add Duplicate Test Window

data in the associated tags will be moved to a 921
(first indicator 1, which means this tag has former
"Romanized" data that was associated with an 880)
with a subfield $6, which has the equivalent tag
number (245, 260, etc.).

Add Duplicate Test - Phoenix%9

Daminatt Tags

Ad: oo
Delete

-

Thiz oceurs when the incoming record has an 001 tag that
beqins with "wtlz" 2 this point, a record number iz computed
from the remainder of the 001 tag. &lsa, the beginning of the
003 tag is checked against the value expected for the current
database. Kthe 001 starts with "wtiz," the 003 tag begins like
the dstabase records, and the computed record number exists
inthe database, then an 001 duplication exists.

Action
RFeplace duplicate record in databasze with incoming record j Merge Mame: |
Ok | Cancel
Add Merge Window
W7 Add Merge - Phoenix99 (=)
Merge Mame: ||
Rules:
Add | Edit Delete
Default Rule:
Specify | Clear
Ok Cancel
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Virtua 949 Label

Before you can run the 949 Item Load program, certain parameters should be set in the
database.

Parameter Purpose

Item-level Call Number set in Cataloging parameters via the Virtua

Flag Profiler

Item class definitions set in Circulation parameters via the Virtua
Profiler

Library locations set in Global parameters via the Virtua
Profiler

By setting those parameters first, you can provide valid values for the following:

Values Location in 949 Tag

Item-level call number Specify in the 949 VIRTUAITEMCALLNUMBER
tag(s).

Item class Specify the item class code as a value in
subfield \X of the 949 VIRTUAITEM tag
(mandatory).

Shelf location specify the shelf location code as a value in
subfield \D of the 949 VIRTUAITEM tag
(optional).

The 949 Item Load program supports two types of 949 tags in the bibliographic or
holdings record. These tags determine the processing of the record. Information from
these tags, plus location and copy number information from 852 tags in the holdings
record, is used to create item records. The two tags are:

949 Tag Purpose

949 VIRTUAITEM tag Contains most of the data for an item record.
Each tag contains information for exactly
ONE item record. You can have as many 949
VIRTUAITEM tags in one record as you want.

949 Contains the data for ONE item-level call
VIRTUAITEMCALLNUMBER | number. The Item Call Number Flag
tag parameter set in the database being loaded

determines the number of 949
VIRTUAITEMCALLNUMBER tags that can be
supported per item record created.
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Subfield \5 stores an integer that is the link between a 949 VIRTUAITEMCALLNUMBER
tag and the associated 949 VIRTUAITEM tag within one record. The subfield \5 is required
if the following conditions are true:

e Multiple 949 VIRTUAITEM tags exist in the record

e 949 VIRTUAITEMCALLNUMBER tags also exist in the record

e The item associated with this 949 VIRTUAITEM tag has an associated item-level
call number.

An item record can be created only from a parent record that exists in the Virtua database
even if that parent record exists only moments before associated items are loaded by the
949 Item Load program.

e Each item created from a 949 item tag in a holdings record is linked to a holdings
record in the Virtua database.

e Each item created from a 949 item tag in a bibliographic record is linked to a
bibliographic record in the Virtua database.

Syntax of 949 Tag: 949 ## \A VIRTUAITEM \D nine-digit location code \V price of item
\W ISO currency code \6 barcode number \5 linking integer \9 units information free text
\X Books

Note: See the Virtua Record Loading User’s Guide for information on additional subfields
used in the 949 tag.
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Creating Items with a 949 Tag

Set the Bibliographic Load Options. In this example, we are creating items only.

Load Options - phoenix E

General Bibliographic (and Community Info) IAL.I'H"IOI'ity | Holdings I Patron I

ILoad Ttem Bib Parent j
I

[~ Create Items: I

[ Require Virtua 949 Label

[~ Shelf Location: I
[~ Item Class: I

[~ Duplicate Tests:

Add Edit Delete
[~ Merges:
add Edit Delete
[~ Mon-Dupl. Action: I ;I
[~ split FRER
[~ Load Options File: I
I~ validation: I ﬂ

[~ Move 880 tag data to associated tags

[~ Local Options File: I = |
Save To File... |

CK I Cancel |
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Add 949 tag to the bibliographic record. Note the item barcode in the subfield \6.

12 MARC Editor - Phoenix99
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Load the record via the Import Tool. An item record is created once the record is
processed.

Advanced Cataloging Workflow-Based Reference Guide Last Revised: Oct 2017

*Updated to 16.1



55

W View Bibliographic Record - Phoenix%% Q@
[T
Ful  tems I marc |
Title: Ciecorating with personal style / [editor, Pamela J. Wilson). Status Counts
ISEN: 0695011700 Checked Cut: 0 On Rezetve: 0
o . ) ) Awailable: o Requested: ]
Publication: Des M I . Meredith Corp., ©1938.
ublication &3 Moines, lowa | Meare orp., C o Hald: o Othar- 1
Description: 224 p. ccol.ill. ; 28 cm.
Format/Edition: 1=t ed. Total kems: 1 Un=atisfied Fequests: 0
Total Requests: 0
Call Mumber shelwing Location Units Status tern Barcode
747 D Technical Services In Processing 55445
4 »
Current Selection: 1 £1 | Wiew ttem | Delete tem ‘ Request kem |
[ Mazked Edit Request Bib ‘ Add tem ‘ Refresh | Close |

Authority Tab

The software automatically performs default authority checking on the 001, 010, and then
the 1xx tags. In duplicate checking, authors and subjects will match without regard to
case (terms are normalized) and the ending punctuation. For example, the authority
heading for Smith, David K. will replace the heading Smith, David k when loaded into the
database.

Protect Local Cross References when Merging Authority Records

Locally defined cross references can be protected from being overwritten when existing
authority records are being replaced by matching incoming authority records.

This option utilizes a local code in subfield $5 of the local cross reference tag. If the code
is defined in the Merge Options of the Authority tab of the Load Options window, then
the local x-ref fields will stay in the resulting record.

Set Load Options for Authority Records

Click the Authority tab. Options set on this tab will affect only authority records.
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Load Options - phoenix E
General | Bibliographic (and Community Info)  Authority |Ho|dings I Patron I
IESU_Merge LI
v Blind References: ILoad blind references ;I
[~ Heading Type: I ;l
v Duplicate Tests:
Add Edit Delete
¥ Merges:
Add Edit Delete
[V Mon-Dupl. Action: IDo not save non-duplicate incoming records. ;I
¥ Load Options File: I
[~ Local Options File: I = |
Save To File... |
[ x| cone |

Click the check box to enable desired features and select an option from the drop-
down list if necessary.
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Settings

Purpose

Database Action

Blind Records

Heading type

Advanced Cataloging Workflow-Based Reference Guide
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Allows you specify which action to take against a file
of input records.

e ESM_Merge: Allows a provisional authority
record to stay as a provisional after
modification

e ESM_Over: Database override; record is
saved to the database and overrides Error
State if a conflict is found.

Note: You can use ESM_Over, for example, if you
wanted the 1xx to become a 4xx and the 4xx to
become 1xx. In Classic VTLS, this is what "over" was
used for. You can use the ESM_Over setting to allow
users to change a 5xx tag in an authority record to a
4xX.

Allows you determine whether or not to load
authority records that will be blind records.

Allows you select Subject as type or specify that
type is determined by tag and other data in the
record. Important: Only used if ‘Do Not Support
Single Authority Record’ parameter is enabled in the
Virtua Profiler.

Profiler Tip: The Do Not Support Single Authority
Record setting lets you determine how Virtua will
interpret the coding in tag 008, positions 14 and 15.
This parameter tells Virtua how to index an authority
record loaded into the database that has the values
aa in tag 008, positions 14 and 15. See Setting the
Cataloging Basic Options Parameter: About the Do
Not Support Single Authority Record Setting in the
Virtua Profiler: Cataloging Parameters User’s Guide
for more information.
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Holdings Tab
Click the Holdings tab. Options set on this tab will affect only holdings records.

Load Options - phoenix

General ] Bibliographic {and Community Infa) ] Authority Holdings lPatron ]

|Load Item Holdings Parent

¥ Create Items: |Pr0cess data in item tags regardless of location

Iv Virtua 949 Label: |A Virtua Label is not needed

v Hold Migration Flag: |N0 holdings migration

[ Shelf Location:
v Item Class:

v Load Options File: |

Led Lef Lef Lol

I~ Local Options File: | =
Save To File...

oK | Cancel |

Click the check box to enable desired features and select an option from the drop-
down list if necessary.
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Settings

Purpose

Database Action

Create Items

Virtua 949 Label

Hold Migration Flag

Shelf Location
Item Class

Advanced Cataloging Workflow-Based Reference Guide

*Updated to 16.1

Allows you tell the software which action to take. For
example, load items and parent records OR create
items only.

Allows you specify the rules by which item records
are created from information in the 949 VIRTUAITEM
tag.

Allows you specify whether a Virtua Label is nheeded
in the 949 tag subfield \a. (See Virtua 949 Label
below)

Allows you specify whether to migrate holdings
records from the classic VTLS system to Virtua.

Allows you specify a shelf location for loaded items.

Allows you specify the item class for loaded items.

Last Revised: Oct 2017
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Patron Tab
Click the Patron tab. Options set on this tab will affect only patron records.

Load Options - phoenix

General | Bibliographic (and Community Info) I Autharity | Holdings Patron

[v Dat [rrryMMDDHH24MI =]
¥ CheckDate: fNo date check =]
[~ Expiration Date: I
[~ Delete Date: I
[~ Duplicate Tests:
Add Edit Delete
I~ Merges:
fdd Edit Delete
¥ Mon-Dupl. Action: IDD not save non-duplicate incoming records. LI

[~ Load Options File: I

[~ Local Options File: I = |
Save To File... |

Click the check box to enable desired features and select an option from the drop-
down list if necessary.
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Settings Purpose

Date Pattern Allows you specify the pattern that the system will
use to interpret the dates found in the 042 tag
subfields \a, \b, and \c of the incoming records.
Currently, there is only ONE date pattern supported.

Check Date Allows you specify whether to check the transaction
date in the 005 tag of the incoming record against
the last transaction date in the database record. If
the transaction date in the incoming record is older
than the date in the database record, then the
record is not loaded.

Expiration Date Allows you specify an expiration date, which Virtua
will insert in tag 042 \b if the date does not exist in
the incoming record.

Delete Date Allows you specify a delete date, which Virtua will
insert in tag 042 \c if a date does not exist in the
incoming record.

Duplicate Tests Allows you determine duplicate tests and database
actions for incoming records based on specified tags.

Merges Allows you create rules for merging incoming
records with existing records so that identified tags
from the existing record will be incorporated into the
incoming record.

Non-Duplicate Allows you specify which action to take against non-
Action duplicate records in a file.

Select an option from the dropdown menu to the right of the desired feature.

Duplicate Tests and Merging Records

Define Duplicate Tests for Incoming Records

You can define duplicate rules in the load options of the Virtua client. Virtua allows you to
match on the following tags of the MARC tags:

« Bibliographic Records: 001, 010, 015, 020, 022, 024, 028, 035.

Profiler Tip: The 015, 024, and 028 tags are only available for bibliographic
duplicate tests if you choose to index them: 015 = Index National Bibliography
Number; 024 = Index Other Standard Identifier; 028 = Index Publisher Number.
See Setting the Cataloging Basic Options Parameter in the Virtua Profiler:
Cataloging Parameters User’s Guide for more information.

e Authority Records: 010, 035, 1xx
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¢ Patron Records: 001, 015, 016

Select Options > Load Options from the drop down menu of the Virtua main menu

Click the Bibliographic (and Community Info) tab.

Click in the check box labeled Duplicate Checks and then click the Add button.

62

In the Dominant Tags area, select a MARC tag number to act as a duplicate check. The
available options are the 001, 010, 015, 020, 022, 024, 028, or 035 tags. You may also

define multiple duplicate tests.

Add Duplicate Test - Phoenix%%

.-\I

Daminart Tags
020

Action

Add:

Delete

020

-

Subfield 'a' in the 020 tag of an incoming record must match the

zubfield 'a' in the 020 tag of an existing record.

Feplace duplicate record in database with incoming record

j Merge Mame: |

Ok

Cancel

In the Action area, select that action that you want Virtua to take when it detects

duplicate records. The choices areto . . .

If you selected the Action Merge the duplicate record in the database with the
incoming record, the Merge Name text box will become active. Type a merge name.
This name will be used to link your duplicate test to the merge rules that you will define
for merging any records that meet the test. For any other Action, skip this step and
proceed to the next step.

Click the OK button.

Advanced Cataloging Workflow-Based Reference Guide
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Replace the duplicate record in the database with the incoming record.

Ignore the incoming record and leave the database unchanged.

Save the incoming record in Error state for later processing.

Remove the duplicate record in the database and discard the incoming record.
Merge the duplicate record in the database with the incoming record.
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Define Merge Rules for Incoming Records

When incoming records are duplicates of existing records you might want to retain some
information from the existing records, and some information from the incoming record.
You can do this by defining which tags to retain and merge with the new, incoming record.

If you specified the Duplicate Test action Merge the duplicate record in the
database with the incoming record, you must now set the Merges option.

On the Load Options window, click on the check box labeled Merges.

Click the Add button. The Add Merge window will appear.

W Add Merge - Phoenix9%

MEX]

Merge Mame: [856Merge

Delete

Fules:
Add Edit
Default Rule: [11E
| Specty Clear
Ok

Cancel

Type the Merge Name that you created when setting the Duplicate Tests option.

Hint: If there are multiple Merge Names defined in the Duplicate Tests window,
choose the Merge Name that you want linked to this particular merge; then repeat the
following steps for every other Merge Name defined in the Duplicate Tests option.

Click on the Specify button to define a Default Rule. This should be the rule that
applies to most of the tags in the MARC records. The Specify Default Rule window

will appear.
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W Specify Default Rule E]

Erter 3 digit tag number ar tag number range separated
by dash. Forexample: 100 or 300-400

[Optionall - Enter indicator character (including space it
desired) or range in the same way. For example 1 or 3-4

Second Indicator Range: [Dptional) - Same az
abowve.
] Keep tags from the incoming record that satizfy the
preceding rahgelz). Fataginthe existing record
zatizfies the rangerz) it will be dizcarded ifthere iz a
tag in the incoming record that has exactly the same
tag field data and alzo zatisfies the rangei=). Fhno
zuch tag exists inthe incoming record, the tag will be

Tag Fange:

First Ihdicator Range:

Merge Rule;

Ok Cahicel

Hint: If you want ALL tags in the duplicate records to be merged according to the same
rule, you do not need to specify any tags for the Rules list box. Simply provide the
Merge Name and specify a Default Rule.

On the Specify Default Rule window, select the Merge Rule, which is the only field
that is enabled.

Hint: A definition of the rule appears to the right of the dropdown menu when a rule is
selected.

Click the OK button.

On the Add Merge window, click the Add button to define exceptions to your
Default Rule. The Add Rule window will appear

W/ Add Rule - Phoenix99 =)

) 256 Enter 3 digit tag number ar tag number range separated
ez (P by dash. For example: 100 or 300-400

[(2ptionall - Enter indicator character (including space it
desired) or range in the same way. For example 1 aor 3-4

Second Indicator Range: [(Dptional) - Same as

abowe.
] keep tags from the incoming record that satizfy the
preceding range(s). Fataginthe existing recaord
zatizfies the rangez) it will be dizcarded ifthere iz a
tag in the incoming record that has exactly the same
tag field data and alzo satisfies the rangeis). Fhno
such tag existz inthe incoming record, the tag will be

First Indicator Range:

Metge Rule:

0] 4 Cancel
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Enter the tag range and any indicators of tags that are to be merged with a different
rule than the default rule.

Choose the Merge Rule from the dropdown menu.

Click OK, the merge rule will appear in the Add Merge window.

W7 Add Merge - Phoenix99 =)

Merge Mame: [856Merge

Rules: TaEEM |E
A Ed Delets
Defautt Rule: |11E
Specify Clear
2k Cancel

Repeat the process for each tag or tag range for which you want to specify an
exception to the Default Rule.
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The MARC Label Editor

Recommended
Workflow Explanation
Access the Virtua provides a mode of editing MARC records called
Label Editor “Use MARC Labels”. This mode uses field labels instead
of MARC tag numbers. These labels can be modified to
reflect specific library needs. The MARC Label Editor
- allows libraries to add, delete, and edit the MARC tag
Lgﬂ't:;:ee labels available on the labeled workforms. These labels
Lgist 9 may also be translated into any language.
Summary
\ e Open the Label Editor
Modify a e Add a new language to the language list
Label e Edit a tag label
e Add a new tag label
A 4
Use Editor in
Label Mode Key Terms
e Label List
e Label Target
e Language List
e MARC Label Editor
Advanced Cataloging Workflow-Based Reference Guide Last Revised: Oct 2017
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Access the MARC Label Editor

The MARC Label Editor gives you a user-friendly interface that allows you to add,
modify, translate, or delete the MARC labels that appear in label mode in the MARC Editor.

On the Virtua menu bar, chose Options - Label Editor. The MARC Label Editor
window appears.

-

.
W/ MARC Label Editor - C:\Program Files\VTLS\Virtua2010.1.3.1\Catalog\abels.rec - Ph... — [0/

Language

|§Defaurt ﬂ Edit Language List

MARC Format

{» Eiblingraphic " Authority " Holdings " Community " Patran " Motes

Label List

Bib-id (zortral number] # | Label Mame

Bib id (contral humber) idertfier
Latest transaction datefime
Additional Fixed Field elements Label Target

Physical description fixed field Tag Murmber Subfield Character |_ | Repestable
Fized length data elementz
LC control number
MUCMC contral number
Ivalid LC cortrol number
Patent number

Country of patent First Indicator Values
Type of patert number
Date of patert

Status of patert

Party to document patett
Matianal biblio. number source Second Indicatar Mame
Matianal bibliography number |
Mat|. bibliographic agency source
Matl. bibliographic agency number
Ihwalid natl. biblio. agency number ‘
Copyright number zource "

Indicators For Tag Mumber
First Indicator Mame

Second Indicator Values

agd | |

Ok Cancel | Aoply |

Note: The file labels.rec, which contains the label definitions, must reside in the
VTLS\Virtua\Catalog directory on each local workstation.
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Elements of the MARC Label Editor Window

Element

Purpose

Language

MARC Format
Label List

Label Name
Label Target

Indicators for Tag
Number

Select an editing language and/or edit or add to the list of
languages.

Select one of six formats to map or edit field labels.

List of field labels, in tag order, assigned to the selected
MARC format.

Allows you to edit a selected label from the Label List

Displays tag number and subfield characters mapped to
selected label.

Displays indicator data for the selected tag.
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Edit the Language List

You can translate the MARC tag labels into another language by adding the language to
the Language list.

Click the Edit Language List button. The Edit Languages window appears.

-,

W Edit Languages ...

Lahguage List

Mewy Language

Lahguage Mame

[y Language|

ey | Delete |

69

Click the New button to add a language to the list. The name New Language appears

in the Language List textbox.
Click the name, which now appears in the Language Name box.

Edit the name, using the same word for the language that appears on the Language
menu in Virtua.

For example:

e use Spanish if the drop-down menu is in English.
e use Espanola if the drop-down menu has been translated into Spanish.

Close the panel by clicking on the X button in the upper right-hand corner of the panel.
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Modify or Translate a Label

Choose a language in the Language box.

Chose the type of MARC Format you need to edit.

W7 MARC Label Editor - C:\Program Files\VTLS\Virtua2010.1.3.1\Catalog\Mlabels.rec - Ph... . [O/E3

Language

|Defaurt j | Edit Language List
MARC Format

{s  Bibliographic " Authority (" Holdings " Community " Patron (" Motes
Label List

Bib-id (control number) | Label Name

Bib id fcontrol number) idertifier

Latest transaction datedime

Additional Fixed Field elements Laiel atpte

Phyzical description fixed field Tag Murmber Subfield Character |_ | Repeatsble

Fixed length data elements

kligi:::ml anI:ml?er . Indicatars For Tag Mumber
coritral hurmber . .

Ihvalid L contral number First Indicator bame

Patent numbet |

Courtry of patent First Indicator Valugs

Type of patert number

Date of patent

Status of patert

Party to docurnernt patert

Mational biblio. number source

Mational bibliography number |

Matl. bibliographic agency source

Matl. bibliographic agency number

Irwalid natl. biblio. agency number

Copyright number source e

Second Indicator Marne

Zecaond Indicator Values

pad | |

Ok Cancel | Anply |

Select the label you want to modify or translate from the Label List. The label appears
in the Label Name box where it awaits editing.

Tip: The labels are in order by tag number and then subfield. Click on labels in the Label
List until you find the correct label.
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W/ MARC Label Editor - C:\Program Files\VTLS\Wirtua2010.1.3.1\Catalog\labels.rec - Ph... - [0/

Language

|Defau|t j Edit Language List
MARC Formnat
{» Eiblingraphic " Authority " Holdings " Community " Patran " Motes
Label List

Cortents table language code # | Label Mame

Accamp. mat. language cade Geographic area code

2Hg. translation lang. code

Authertication code Label Target

Local GAC code sourte | Tag Mumber (043 Subfield Character |ﬂ_ ¥ Repeatable

Geographic area code

Local GAC code Indicators For Tag Mumber

150 GAC code . ’
First Indicator R
Pub. subertity code source | IS nCcao Tame

Publisher country cade

Pub. local zubertity code

Pub. courtry |50 code

Time period cade

Farmatted time periad code
Farmatted pre-9993 B.C. code
Special coded date type Zecand Indicator Mame
Special coded date 1 B.C. |
Special coded date 1 C.E.
Special coded date 2 B.C.
Special coded date 2 C.E. ‘
Farm of musical composition code "

First Indicator Yalues

Second Indicator Values

Add | Delete |

Ok Cancel | Aoply |

Edit the label in the Label Name box.
In the Label Target area, edit the Tag Number, to which the label will be mapped.

Click the Apply button to remain in the editor or the OK button to save the changes
and exit the editor. The label file is saved only if changes have been made.

Note: Changing the language option under Options > Language will automatically

change the language of the labels, provided they have been translated in the Label
Editor.

For example:

e If you have translated labels into Chinese, they will appear in the MARC Editor in
Chinese if you change the Language Option to Chinese.

e If the labels have not been translated into the chosen language, the labels will
default to English.
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Add a Label

Click the Add button in the Label List area.

The label New Label appears in the Label List and in the Label Name box where it
awaits editing.

Edit the label in the Label Name box.

In the Label Target area, specify the Tag Number.

Add the next label by pressing the ENTER key or clicking the Add button.
When you are finished editing, click the OK or Apply button.

Delete a Label

Select the label to delete from the Label List.

Click the Delete button. The software asks if you are sure you want to delete the
label.

Click the OK button. The label is removed from the Label List and the next label
below is highlighted.

e If there is no label below, the label above is highlighted.
If there is no label below or above, all the controls below the MARC Format area
become disabled.

Cancel

Click the Cancel button. A warning dialog appears if the user as has made changes. If
changes have not been made, the window closes.

Confirm W

9 Do wou wank to save wour changes?

-~
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Use the MARC Editor in Label Mode

On the Virtua menu bar, click Options > Cataloging Options. The Cataloging Options
dialog box appears.

Click the Display Options tab and select the check box labeled Use MARC Labels.

W Cataloging Options - Phoenix99 E]
File Cptions l Copy Options 1| r

MARC Labels
[v Use M&RC Labels © Horz. Max. Label Extent:

{* Wert.
Label Saurce File:

CAProgram FilesWTLEWIHWa2010.1 3.1 Catal (=

Subfield Delimiter: Mon-Sorting/Filing Marers
(O % v | (" fand}

Tags not to Display aor Add:

[ lgnore WTLISORT Tag
v Dizplay 830 tagiz) after linked tag

Ok | Cancel

Select either horizontal (labels appear to the left of the tag) or vertical (labels appear
above the tag).

Advanced Cataloging Workflow-Based Reference Guide Last Revised: Oct 2017
*Updated to 16.1



W Cataloging Options - Phoenix99 m

d

File Options | Workforms  Displey Options | Copy Options 4 ¥

MARC Labels
[V Use MARC Labels (¢ Horlz. Max. Label Extert:
™ Vet 0% -
Label Source File: —_—
20% A
|C:'1F'n:|gram FilesWTLSWirtua201 0l 5.
0%
B0%
Subfield Defimiter: Mor-Sof 60 ¥
(s " % " | [70%
BO%
S0% il

Tags not to Display or Add:
[~ Ignore YTLSSORT Tag
¥ Display 560 tag(s) after linked tag

| oK | Cancel

Note: If you chose horizontal, the Max. Label Extent dropdown becomes active,
allowing you to define how much of the MARC Editor window will be occupied by the
label.

Horizontal Mode Vertical Mode

& MARC Editor - phoenix (- J[OJEd| |EMARC Editor - phoenix (=<

Fixed length data elements [B50829t20052004nyu 000 lenad | 2 Fixed length data elements
09050152009 miu 0000 engd |
Invalid LC control number [_|[ ] [2004-042517 |

1s8n ][] [0060777338 (pbk.) :

ISBN
[ ][ ][e7s1598062153 ; |

|
ISBN terms of availability | §17.95 | ISBN terms of availability
$40.00 |
Local control number ][] [(0CoLC)ocme1335630 |
ISBN
Original cataloging agency [ |[|[16= | ][] [z5es062150 |
Transcribing agency | IG# | Original cataloging agency
Dewey classification number [0 |[4 |[813/.54 | 1] [ercra |
Transcribing agency
Dewey edition [22 | [ETCcTa |
Tag 092, Subfielda [_][_][812 | Modifying agen
Tag 092, Subfield b [ERADBURY | 25 |
Tag 049, Subfield
Author, Personal name (PN) I:l | Bradbury, Ray, | l:l l:l ’fgf’u— 2 |
E =
|(a) Language material L' {m) Monograph,Ttem j [~ Masked | (a) Language material L| (m) Monograph,Ttem ﬂ [~ Masked
< | > MARC 21 Bib: Book OPAC < | = MARC 21 Bib: Book CPAC
“OPAC1 ADPAC2 / VOPACT /
Click the OK button.
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Open a label workform such as booklab.wfm or bring in an existing record. The MARC
Editor appears. All editing functions available in standard mode work in label mode.

Add or edit the data for the labeled field.
Edit each indicator box. To do this, in each box

e Click the left mouse button to see the name of the indicator.
e Click the right mouse button to see the appropriate values for the indicator.

Save your work.
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Authority Records

Recommended
Outline Explanation
Add an Virtua MARC format for authority records is based on the
Authority USMARC authority format. With Virtua, you can easily add
Heading existing authority headings to bibliographic or authority records
that you are creating or editing. This procedure for adding
headings works with any heading under authority control:
Merge an e Authors
Autho_rlty ¢ Subjects
Heading e Series titles
e Uniform titles
AddANE’rt]es_;‘o Operational security settings in the Profiler allow libraries to
an Authority restrict which staff have permission to edit and delete authority
Heading o .
records. Permissions can be set separately for each authority
record type (i.e. Author, Subject, etc.)
Summary
e Add an authority heading
e Merge authority headings
e Add Notes to authority headings
e Distinguish between provisional and permanent authority
records
e Distinguish between types of Cross References (See, See
Also)
Key Terms
e Authority Heading
e Authority Notes
e Authority Record
e Cross-Reference
e Established Heading
e Permanent Authority Record
e Provisional Authority Record
e See Also Reference
e See Reference
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Profiler Parameters

Authority Messages

Additional Access Points

Heading Replacement Flag

MARC Heading Conflict Flag

Operational Security

Automatically Update Tags of Bibliographic Records
Common 1xx/6xx Authority Record

InfoStation Reports

Authorities List: Generates a list of authority records
that meet the authority type, Cataloging source code,
and date range criteria as specified in the configuration.
Cataloging Errors: Generates a list of cataloging errors
that meet the date range and Virtua user criteria set in
the report configuration.

Records by State: Returns a list of records in the
selected state.

Indexed Words: Generates a list of indexed words in
the bibliographic records in the database.

Subject Bibliography: Lets you select a set of subject
authorities and produce a set of related bibliography
entries.

Advanced Cataloging Workflow-Based Reference Guide Last Revised: Oct 2017

*Updated to 16.1

78



79

MARC Authority Record Format

An authority record is a tool librarians use to create standard names for the persons,
places, titles, subjects, etc. that are found in bibliographic records. Authority records
provide a controlled vocabulary and cross reference system for accessing bibliographic
records.

In Virtua, authority records may be based on:
e Subjects

Authors/Names

Series Titles

Uniform Titles

Authors/Titles Series

Special User-Defined Categories

Subdivision (Subjects)

Genres/Forms

Profiler Tip: Library-defined browse and heading keyword search definitions are set in
the Tags Indexed for User Defined Search parameter in the Virtua Profiler. A library-
defined search is a type of custom heading search for which your library can determine
indexing rules. You can determine which tag/subfield/indicator combinations are indexed
for your library-defined search. See Defining Tags Indexed for User Defined Searches in
the Virtua Profiler: Cataloging Parameters User’s Guide for more information.

Virtua provides several ways to view and search authority headings:
e Browse Subject search: Places you in an alphabetical list of all subject headings
e Multiple Subject Thesaurus searches: Places you in an alphabetical list of all
subject headings for a specified thesaurus, e.g. LCSH, MeSH, NAL, Etc.
¢ Keyword in Heading search: Places you in an alphabetical list of subject
headings containing the word or phrase searched.

Profiler Tip: The Multiple Subject Heading parameter lets you enable functionality related
to multiple subject headings. By enabling and configuring this parameter, you can index
multiple subject thesauri and make them available for searching in the OPAC. Important:
Before you try to enable multiple subject headings, we recommend that you contact
Customer Support, especially if you have ANY questions about the proper process. If the
process is not executed correctly, damage to your database can occur. Warning: Once
the Multiple Subject Headings parameter is enabled it is permanent. See Setting the
Parameter for Multiple Subject Headings in the Virtua Profiler: Cataloging Parameters
User’s Guide for more information.

Common Authority Records for 1xx/6xx tags
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Authority records for authors may also have corresponding subject authorities. Your
library may decide to treat name and subject authority records in one of two ways. You
may either:

e Have two separate authority records, one for the name authority and one for the
subject authority

e Have one common authority record that is indexed under both author and subject
and will be retrieved by either search.

In the Virtua Profiler, under the cataloging tab, you may set the parameter to enable
common authority records.

Note: The use of a common authority record will only apply to permanent authority
records in the system and not provisional authority records.

Note: If you do not wish to have the option of using common name/title and subject
authority records, then you can enable the Do Not Support Single Authority Record
parameter in the Cataloging Basic Options window in the Virtua Profiler. In that case you
would always have separate name/title and subject authorities and the 008 would not be
taken into account.

Permanent vs. Provisional Authority Records

In Virtua, authority records are of two types: Permanent and Provisional.
Permanent authority records are intentionally created as MARC authority records to:
e Establish an authoritative form of a heading in the 1xx field,

e Create any reference headings in the 4xx and 5xx fields, and
e Provide any other supporting information according to the MARC standard.
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MARC 21 Authority: Authority CPAC

Provisional authority records are automatically created by Virtua because the term in
question is in a 1xx, 4xx, 6xx, 7xx, or 8xx (NOT 240) field of a bibliographic record.
Provisional Authority records:

e Exist because an authority heading is created whenever you add a bibliographic
record to the database.

e Reside in the same authority file as permanent authority records

e Contain only a default 008/LDR, a 1xx tag, and a 001 tag.

e Can be changed to Permanent authority records by opening the provisional
authority record in the MARC editor and re-saving it to the database.

Note: The Heading Replacement Flag parameter in the Profiler determines how
Virtua handles MARC record headings that are similar to an existing authority heading.

e If you set this flag to YES, all headings in an incoming bibliographic record that
match the sort form of an existing authority record, but are different in detail
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(capitalization, subfield coding, ending punctuation) are replaced by the 1xx of the

existing authority record

e If you set this flag to NO, all headings in an incoming bibliographic record that
match the sort form of an existing authority record, but are different in detail
(capitalization, subfield coding, ending punctuation), are given a warning message

of possible duplication.

We suggest this parameter only be set to Yes with great discretion.

To view an authority record in the MARC Editor:

To open an authority record, do a Browse subject search in the OPAC

W Search - Customer Support Library

=,

Browse l Heading l Keyword l Control Number | Holdings Keyword l Patron l

| subject | fart
To begin a browse search of the library catalog,

2. Then click in the empty box.

LIBRARY NOTICE

1. Choose the type of search by clicking the arrow in the first box.
3. Type a whole or partial last name, subject, fitle, call number or

other entry appropriate to the type of search you are deoing.
4. Click the Search button or press the ENTER key on your keyboard.

M semane macmbmmnim e Eheme s mrmmmm s bmem e mm mscme s mbbome dme

[

Location

Search

Cancel

From the Browse screen, select the authority record and right-click to open the View

Authority Record window.
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I
¥ Browse - Customer Support Library _ (= E
Subject: art
Hitz | Terms What's This? I
-+ 7| At ISH{_-:=DLC]_ Mext Search Ctrl+Tab
0|4t & design senes  [SRC=DLC) Previous Search shift4Ctrl4Tab
1[Art — 15th century — History — Ju New Search
% 0| At — 16th century i =Ear
- Art — 15th century Copy Heading crl+c L. |
JL0L, Abstract [SRC-DLCI Merge Heading Ctrl+v 3
1[Art, Abstract — Juvenis iterature.
1[Art, Abstract — Technigue. View Authority
1| Art — Adaptations [SRC=DLC] Add Authority to Editar
+ O] Art, Azgean Renlace Heading in Editor
Copy
Print.
Save
E-mail —
Subject: art
View I Page Up Page Down Skap Delete
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Select View Authority; the authority record will open in the View Authority Record

window.

W View Authority Record - Customer Support Library

=Jo/es

LDR 00637nz a2200217n 4500 Ii]

001 viis000E06892

003 NcFayC

005 20070901161209.0

005 0603 15i| anannbab |z ana |||

010 \a sh 86007522 =

035 \a sh 85007522 1

039 9y 200701252316 'z VLOAD

040 ‘a DLC \c DLC

053 ‘a ME430

150 0  ‘a Ar, Abstract 0|

450 0  ‘a Abstract art

450 0 ‘a Art, Non-chiective

450 0 ‘aNen-chjective art [se]
Wiew Archive Edit Refresh | Close |
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Use the right-click menu to display authority record options:

W View Authority Record - Customer Support Library E]@
141
Ful  MARC ]
LDR 00537nz aZ200217n 4500 What's This? )
001 viisDODE06892 Print...
003 NcFayC Save...
005 20070901161209.0 E-mail...
003 060318i bab b
| anann 1b-ana i Save Copy to Database
010 ‘a sh 86007522 =
035 ‘a sh 85007522 Copy Ctrl+C
039 9 200701252316z VLOAD
040 ‘a DLC o DLC
053 ‘a NG6490
150 0 s At Abstract Generate ISBN Letters
450 0 ‘s Abstract art Generate Remm.der Letter _
450 0 ‘aAt Nonobjectve generaz Enje:!verej sn?k:enl'u;der. , |
T 0 \aNonobjective art enerate Undelivered Periodical Reminder v)
‘ Edit Close

Click on Edit to open the record in the MARC Editor.

& MARC Editor - Customer Support Library

(e |
I

e J[ ][]
L]
o]
[ o]
[ [e]
[ o]
L]
LI

HEE
[ ]
[]

|
|| B
(AU B =1

DDDDD@DDD
EEEE

noen
noen
[

| 0605181 anannbab |bana |||

[ 2 sh 85007522

| \a sh 85007522

[\aDLC\cDLC

| \a M40

| ‘@ Art, Abstract

| ‘a Abstract art

| ‘a Art, Mon-cbjective

| ‘a Non-objective art

| w g 'a Art, Modern v 20th century

| ‘w g \a Modernism (Art)

|(z) Authority data

* | (y) Subject

MARC 21 Authority: Authority

ORAC

OPAC1

1
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Tag | Purpose

1xx | Established Heading: Correct term established by agency (LC, etc.)

3xx | Complex see also references: Defines how term is used. The 360 tag will
display as a note in the OPAC.

4xx | See references: Terms not used. These are cross-references that lead from
an unauthorized heading to an authorized heading. They serve as other
entry points: see 1xx heading from the 4xx heading.

5xx | See also references: Terms used to describe similar subjects or alternate
names, broader, narrower terms. They lead from one authorized heading to
another authorized heading.

Note: Sub-field /w is used to define broader and narrower terms.

68x | MARC tags that contain notes defining the 1xx tag.

999 VTLS Tag

The 999 Virtua tag is automatically generated in a MARC authority record and contains
two-locally defined fixed fields: Local Level and Bib Level. According to the MARC 21
format, there is no Bib Lvl (Leader 007) for authority records, but in Virtua there is a
requirement for a locally defined Bib Lvl.

Bib level information is displayed at the bottom of the Authority record.

& MARC Editor:2 - Phoenix99 M=

[ wisonos0eesa

| MeFayC

| 2008017164290

| 06031 8i| anannbabn |2 ana |||

|
|
|
|
[ 12 sh as007451 |
[ 12 sh BE007 481 |
|
|
|
|

[y 200701262316 2 vLOAD
[wDLciwDLc W DLE
[N

[ 2 ant

= [ [ O o i O e Y
[ Wl (= (]|2]|=
(= h ¥ ol ||| ]| e

IO

N { I |
LIEILEIL

|(z) Ay thority data |~ (%) Subject j
g > MARC 21 Authority: Authority QPAC

WOPAC1

The following Bib Level values are defined in Virtua for authority records to determine
whether the record is an author, subject or title:
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Value Description

y subject record (searchable as a subject)

X author/name record (searchable as an author)

e author/title (not series) record (searchable as an
author)

t series title record (searchable as a title)

u uniform title record (searchable as a title)

f author/name series record (searchable as an author)

g author/title series record (searchable as an author)

z special library-defined record

d subdivision authority record (searchable as a
subject)

w genre/form record (searchable as a subject)

The following Bib Level values are defined in Virtua to distinguish between non-

authoritative headings and authoritative headings that appear on the Browse window in

the OPAC:
Value Description
n title record (searchable as a title but the authority
record will not appear in the client)
o] name record (searchable as an author but the
authority record will not appear in the client)
p subject record (searchable as a subject but the

authority record will not appear in the client)

86

The following Bib Level values are defined in Virtua to indicate an authority heading that is
an Additional Access Point, formerly called a “pseudo”:

Value

Description

AAP author/name record - represents the author
portion of a combined author/title field (searchable
as an author, but the tag is not displayed in the
bibliographic record in the client).

AAP title record - represents the title portion of a
combined author/title field (searchable as a title,
but the tag is not displayed in the bibliographic
record in the client).

AAP author/title record - represents the 1xx and
240 fields of a bibliographic record (searchable as
an author, but the authority record will not appear
in the client). The View Authority command is
disabled for a heading with a Bib Level of I.

AAP title record - represents subfield $a of a
uniform title (searchable as a title, but the tag is
not displayed in the bibliographic record in the
client).
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h AAP title series record - represents the title portion
of a combined author/title series field (searchable
as a title, but the tag is not displayed in the
bibliographic record in the client).

Profiler Tip: Additional access points (AAPs) provide an additional link to a record on the
Browse window. You can use the Additional Access Points parameter to determine how
Virtua treats Additional Access Points (AAPs) in the browse list. See Creating Additional
Access Points in the Virtua Profiler: Cataloging Parameters User’s Guide for more
information.

W View Authority Record - Phoenix%9 E]@
B
Ful  MARC |
LDR 00236nz a22000970 4500
0o wilz0005661 41
003 MeFayC
005 20101119163123.0
os 101119 | acn||bab) nala d
160 ‘a Geology 'z Arizona 'z Grand Canyon.
999 a WIRTUAZD W
‘ Edit ‘ Cloze
Example:

e The 999 VTLS tag indicates that this authority record:
Is a provisional authority record (position 7=2)
Is not part of an analyzed series (position 8=0)
Is a subject record (y), searchable as a subject

008 Fixed Field Editor

You have two choices for editing the fixed fields of a MARC authority record from the
MARC Editor window.

e If your Cataloging Options are set with Edit 006, 007, 008 in Editor unchecked,
then clicking in any of these tags will open the tag the Fixed Field Editor.

e If your Cataloging Options are set with Edit 006, 007, 008 in Editor checked,
then these tags can be edited in the MARC Editor window.

Uncheck the Edit 006, 007, 008 tag in Editor option on the Cataloging Options
window.
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¥ Cataloging Options - Customer Support Libr...

Validation Options

v Show Delete Warnings
|v Edit 00&, 007, 008 in Editor
| Owerwrite Variable Fields

[ Print request slip for new
trapped items

Bibliographic MARC Format

[~ validate when Saving to File
[ validate when Saving to Database
[ Use Specific Bibliographic Rule Files

[ Mask New Records
|+ Use Multiple Editors
[+ Use Patron Editor
[ Use NSSAW Editor

Analytic Record Control
Mumber Source Tag

Huoldings Spine Label Subfields

|MARC 21 |

Email Reply To Address

Editor Keystroke Mappings ] Label Printing  Other Options l alr

001

v 035

i

Default Library Symbaol

Email From Address:

o |

Cancel

Click in the 008 field to bring up the Fixed Field Editor window:

% Fixed Field Editor

Authority 005 Fixed Fields

Local Lwl: ’41_

Enc Lwl:

|C0mplete authority record j

Cat Lang: |Nu:| information provided ﬂ

Subj:

|LC Subject Headings

Hd Main: | appropriste

[

Subd Type: | ot spplicable

[

[

Updating: |Recnrd cah be uzed

Mod Rec: | Not modified

031126

Ertered:

E

[

Ath Lang: |Abkhaz (ablk) j
Geo Subd: | Not applicable ~|
Fec kind: |Estal:||i3hed heading j
Series Th: | Mot applicable ~|
Hd Subj: | appropriste ~|
Gonwt A |Na atternpt to code j

P=nl Mame: |D'r|‘fer'entiated name j

Source: |Nationa| bibliographic agenﬂ

Wirtua: |2EIEI?D1 21185

Rec Stat: |Corrected or revised j

Raorman: |No attempt to code j
Cat Rules: | AACR 2 -
Murnb: |Nc|t applicable j

Hd Series: | Mot sppropriste |

Ref Eval: | Not consistent with the hes v |

Estab Lvl: |Fuly established |

Uzed: |2EI1 01011142

Ok ‘ Cancel
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The Local Lvl value found in the top left of the window, indicates how the record entered

the Virtua system.
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0 - transferred from a bibliographic utility (OCLC, RLG, etc.)
1 - copied from another Virtua database

2 - a provisional authority record

4 — created locally online

5 - loaded via a batch job

Note: Except for local Ivl 2, the VTLS locally defined field local Ivl is the same as for
bibliographic records.
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Create Authority Record from Bib Record Headings

You can create a permanent MARC authority record with data from heading fields on the
bibliographic record.

From the View Record window, right mouse click to bring up the pop-up menu.

W View Bibliographic Record - Customer Support Library
ﬂ ;I 10412
Ful | tems [MARC]
LDR 00960nam a22003131a 4500
001 viis000218317
003 NcFayC
005 20120501085100.0
008 92101651992 nyua j 000 1engd
010 \a 52-52008
020 \a 1564581128 :\c §7.95
035 \a (OColLClocm267IET45
039 8 = 201205010851 b VLOAD \c 200701170101 'd WLO:
040 3 WIA e WIA W HOB
048 \a HQBA
L5 \a E'a TAYLOR
100 1 \a Taylor, kim.
245 1 0 ‘aBulterfly /\c photographed by Kim Tayior ; [written &
[~ Masked  Agency Req r Edit

What's Thas?

Print...

Save...
E-mad. ..

Bib Requests

Hold Bib for Merge

Create Holdngs Record
Create Holdings from Workform

[ >

Create Analytic Record J Close I

Create Authority Record(s)...

BEX]

Select Create Authority Records(s). The Create Authority Record(s) window will

appear.
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¥ Create Authority Record(s) - Phoenix99 E]@

Check the headings you wart to use to create authorty records:

w100 Ya Twwain, Mark, W 18351910,

v 240 e Adventures of Huckleberry Finn. Y Portuguese
650 % Finn, Huckleberry (Fictitious character) w Fiction.
B50'a Boys w Travel = Mizsissippi River w Fiction.

v iB50 'a Bovs 'z Miszour b Fiction.

E51 Ya Missizsippi River w Fiction.
B51 a Miszour w Fiction.

655 Ya Adverture fiction. 2 gsafd

B85 'a Humorous stores &2 gsafd
700 = Sales, Herbetrto,

Check Al | Unicheck &l |

(014 | Cancel |

Click in the checkboxes to select the authority records you wish to create.

Merge Authority Headings

Virtua lets you merge authority headings based on Bib Level values. The Merge Heading
command is disabled for headings that are cross-references (4xx, 5xx) or AAPs (7xx) and
for headings belonging to records with an authority Bib Level of *n’, ‘o’, 'i’, 'k’, 'l’, ‘m’, or
‘h'.

On the OPAC toolbar, click the Search icon .

Search for the incorrect heading.

On the Browse window, highlight the incorrect heading.

Click the right mouse button. The right click menu appears.

Choose Copy Heading.

Search for and highlight the correct heading, which you want to use to replace the
incorrect heading.

Click the right mouse button.
Choose Merge Heading on the right-click menu.

Note: The resulting merged heading retains all the cross-references and notes from both
original headings.
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Alert: When a permanent authority record is merged into a provisional authority record,
all tags from the permanent authority records are kept the same except for the 1xx tag,
which is changed to match the provisional record.

Temporary Merge and Override

If a MARC Authority record is active in the MARC Editor, you may temporarily override the
Database Action load option set in the cataloging Load Options window for authority
records when saving authority records from the MARC Editor. Two overrides are available.

¢ Database Action | Merge will temporarily set the action to ESU_Merge. Allows a
provisional authority to stay as a provisional after modification.
o Database Action | Override will temporarily set the action to ESU_Over. If a

1xx/4xx conflict is found, Virtua will override the Error state and save the record to
the database.

To temporarily set the Database Action:

With an Authority Record open in the MARC Editor window, right click to open the
pop-up menu.

Select Database Action.
Select Merge

-OR_

Select Override.

When you save the record to the database, this setting will override any settings in the
Load Options window

Add Notes to Authority Records
Notes about a 1xx heading may be added to an authority record.

From the Browse window, highlight the cross-reference (indicated by the +) to which
you want to add a note.

Right click and select View Authority.
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In the Marc Editor, select Edit. The following note tags may be added:

Note Note Description

Tag

360 Complex see also reference - subject
667 Nonpublic general note

678 Epitome

680 Public general note

681 Subject example tracing note

A notepad icon will appear in the Cross References display window indicating that a
note has been added.

FW Cross References - Phoenix%9 g@“

You searched on:

. Bachman, Richard ............ mew |

Related terms ane:

179 King, Stephen, 1947-

Wiew Browsze Motes:
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Creating Cross-References

Recommended
Outline Explanation
Add an Virtua MARC format for authority records is based on the
Authority USMARC authority format. With Virtua, you can easily add
Heading cross-references to authority records that you are creating or
editing. The procedure for adding cross references works with
any heading under authority control:
Merge an e Authors
Autho_rlty ¢ Subjects
Heading e Series titles
e Uniform titles
AddANfc’rt]es_;‘o Operational security settings in the Virtua Profiler allow libraries
an Authority to restrict which staff have permission to edit and delete
Heading . L
authority records. Permissions can be set separately for each
authority record type (i.e. Author, Subject, etc.)
Summary
e Distinguish between types of Cross References (See, See
Also)
e Add See references
e Add See also references
e Add narrower and broader terms
e Add earlier and later terms
e Understand 1xx/4xx Authority heading conflicts
Key Terms
e 1xx/4xx Conflict
e Authority Heading
e Cross-Reference
e Established Heading
e Invalid Heading
e Valid Heading
e See Reference
e See Also Reference
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Viewing Authority Cross-References

96

The ability to provide cross-references is one of the main purposes of authority records.
Here are some aspects of how Virtua handles cross-references:

See Also references are indicated by a + (plus sign) next to a heading. See Also
references are generated by a 5xx tag in an authority record

W Browse - Phoenix%9

BEX]

Subject: histany
Hitz | Terms
Gp 8 Hiztory [SRC=DLC]

I
2| History — st century — 28 Also |
3 [History, Ancient [SRC=DLC)
Hiztory, &ncient — Biography
2 [History, Anciert — Chronology  [2R.C=DLC]
2 |History, Anciert — Comic books, strips, etc.
4|History, Ancient — Fiction.
0
4
1

0 <k

History, &ncient, in ltersture [SRC=DLC]
History, &ncient — Juvenile literature.
History, Ancient — Miscellanea.

Subject: histany

Wiew Page Up | Page Daown | Skip

| Delete

See references are indicated by a - (minus sign) next to a heading. See references are

generated by a 4xx tag in an authority record.
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FW Browse - Phoenix99 g

Athor: tuen,
Hitz | Terms
1| Twedten, Benet [SRC=DLEC]
= Twen, M. (Mark), 1535-1310
= Twen, Mark, 1535-1910
3| Twer, David F. [SRC=DLC]
= Twerski, Yitshalk
= TWMZ [Corporate Marne]
= T [Carporate Mame]
G| T Ontaro [Corparate Mame] [SRC=DLC]
2| TS (Firmn : Great Britain) [Corporate Mame] [SRC=DMLM]
= TS International [Corporate Mame]

Author:; twen,

Wiewy Page Lip Page Dawn Skip Delete

Note icons indicate that you can view notes associated with a cross-reference. Notes
derive from specific tags in the authority record and include ALL the subfields found in
those tags. A Notes icon appears

e If the record contains a 6xx tag with a second indicator of 9.
If the record contains a 360 tag with a second indicator of 9.

e If the record contains a 678 tag, 680 tag, or 681 tag regardless of the second
indicator.

Advanced Cataloging Workflow-Based Reference Guide Last Revised: Oct 2017
*Updated to 16.1



[ Crow Referemces Proems®y  LO&|

“fou =earched on:

7 Bachman, Richard

Related termns ane:

Wi

Browse

Motes
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Cross-References

Cross-references are created when the subject heading in the 1xx tag of one authority
record appears in the 5xx tag of another authority record.

The authority record for Art contains the term Art in the 150 tag.

W View Authority Record - Phoenix99 E]@
J J 11
Ful  MARC |
LDR 01518nz 822003370 4600 ]
001 wilz000506653
a3 MeFayC
005 200801 7154123.0
0o0s 0B0&1 8i| anannbabn la ana |||
010 'a =h 8007481
035 'a zh G5007461
034 9w 200701252316 'z WLOAD
040 wDLCw: DLCW DLC
053 0o wah
150 'a Art
360 i subdivizion a At under narmes of individual persons who lived before 1400, under names of deties and mythological
or legendary figures, and under headings of the type [topic]{subdivision], .9. % Mary, Blessed Wingin, Saint—Ar;
Zephyrus (Greek deity)—A; Holy Cross—Legends—2&rt; i also subdivision 'a In art Y under names of countries, cies, [,
‘ Edit ‘ | Cloze |

The authority record for Arts contains a cross-reference for Art in the 550 tag.

W View Authority Record - Phoenix99 E]@
ol
Ful  MARC |
Qs 0B0ET 51| anannbab| & ana || A
(] 'a sh 85005324
035 'a zh 55005324
039 9 a 201011131641 b staff w 200701262318 'z VLOAD
00 WwhlCw DLCW DLC
180 ‘a Aris
360 Y zubdivision \a In art i under names of courtries, cities, etc., and under names of individual corparate bodies; and
headings of the type [topic] in art, e.9. 'a &utomobiles in art
450 o ‘a Arts, Fine
450 i} W nhe 'a Arts, Cccidental
450 0 aAds, Westem
450 0  ‘a Fine arts
a50 o w g '3 Humanities
] o a Art y
~— [ Y PR - - - _y - - P TR [ QI - - [ - “ —— - v
Edit Cloze
Advanced Cataloging Workflow-Based Reference Guide Last Revised: Oct 2017

*Updated to 16.1

99



100

Earlier, Later, Broader, & Narrower Headings

Labels to the right of the heading indicate Broader, Narrower, Earlier, and Later

references
These labels are generated by a subfield \w in the 4xx or 5xx tag in an authority record.

W Cross References - Phoenix?9 g@
You searched on;
3 REIIQIDH Er'llj Dul‘tur‘e _. ............ mew ............. ._ |
Related terms ans:
O Civil religioh [hatromer]
Erowsze Motes
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Earlier Headings

When the established heading in the tracing field is an earlier name for the heading in
the 1XX field, it is displayed as a \w a in a cross-reference.

Example: 550 tag \w a \a oleomargarine

W View Authority Record - Phos

=]

Full H!RG|

8 8

=2
=

o o o o o

$EEB22E888EF

HHM118163632.0
060681 8i| anannbab
‘& sh B5061045

e £h BS0E1 045

T 201191846 &
wDLCcDLCW D
‘a TPESA M3 'c Mat
'3 Margaring

‘s Buiter, Atificial
o Margaein

‘wi g 'a Oifs and fatg
we & 'a Oleomargarn
A WIRTLUA ¥
a8 WTLSSORTOMD

101

hﬁ' Cross References - Phoanix99

Wi gearched on:
Chs0mangaring

Mo tiles are available for this term. Relsted terms ane:

0 Mangarine
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Later Headings

When the established heading in the tracing field is a later name for the heading in the
1xx field, it is displayed as a \w b in a cross-reference.

Example: 550 tag \w b \a 3Com park

|
W Cross References - Phoenix99 H[EI]E]

o View Authar ity Record - Phoenix%9
JJ Al [ ou seanched on:
Full ml 3 Com Park | prwy |
LDR 003360z aZ2001 3530 S500
P I titles are awalable for this termn.  Felsted terms ars:
005 2 M1 HESI3R0
oS 10111 9nn acnrnsabn |
34 8y 01181653 'z stalf
150 ‘n Condiestick park
550 we b A 3 Com Park
] ta VIRTLAG ¥
o ia VTLSSORTO0S SO0
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Narrower Terms

The heading in the tracing field is a narrower term than the heading in the 1XX field.
This is indicated by a \w g in the 550 tag of the record that contains the related term.

Example: 550 tag \a Literature and history. \w g

W View Authority Record - Phoenis =1
: W Cross References - Phoenix99 Q@

—|—|1” Wil Searched on:

Ful | MARC | History and Rereture I N I

Mo tlas are avallable for this term.  Ralsted terms are
.

a =h BEDTTEES 2 Literature and history [rineroemer]
s =h BE0TTEES
9 a2MM11HESS b sta
WOLC e DLC W DLC
s PMS0

‘e Literatune and hiztor,
0 & Hstory and poetry
0w Postry and history
e @ ' History

0 wg'a History and Ben
A VIRTUA ¥
T WTLESORTO0 07003

BBEEEL2RE8R2E88

Advanced Cataloging Workflow-Based Reference Guide Last Revised: Oct 2017
*Updated to 16.1



104

Broader Terms

The heading in the tracing field is a broader term than the heading in the 1XX field. A
broader term is indicated by a \w h in the 550 tag of the record that contains the related
term.

Example: 550 tag \a Arts. \w h

W | % Cross References - Phoenix®9 [;—]'El
J J 154 “fiou searched on
foom View | Motes |
Full MR |
_V\'V—f_w‘f"\"""""] [—
|| Pelsbed terme are: e
040 o DLC ‘e D P wrm—— i -
=i ir & T ~
E ol 0 Sartos (&) [FaTer]
""m"g: 4 Sculphure {rammomer]
Lot 1 Shaker s [ramowver]
450 0 s, anl 2 Sihoueties [y ]
450 0 ‘&M, Ocg 2 Space (Art) [nesTower]
460 D o Ads, Wes g ir“'bf"'m ::* :nmﬂ
) Benagers’ i
&0 0 iaFine aris 3 Toirismm and art | rarroweer]
1] 0 & Humsards 3 Video art [narromer]
550 0 ‘wihaaA 9 Wiearable art [ramoer]
B8 i Here are o 2 Wildife art [nammower] ']
works on B e A [Eroader] ],
B W Mote unide
9o s WIRTLA Views | Browese ] Motes | -
|
|__es | | o |

Authority Heading Conflicts

Authority heading conflicts occur when headings used in bibliographic records match the
4xx tags in authority records.

An authority heading conflict is as follows...

e 1xx tags in authority records contain valid headings (terms that are used)

e 4xx tags in authority records contain invalid headings (terms that are not used)

e 1xx, 7xx, 4xx, 8xx, and 6xx tags (subject headings) in bibliographic records are
saved as 1xx tags in authority records when a new or edited bibliographic record is
saved to the database, creating new authority records.

e Virtua cannot create an authority record with a 1xx tag for the tag in the incoming
bibliographic record if a 4xx tag for that term already exists in another authority
record.

This is called a 1xx/4xx conflict.
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When Virtua attempts to create an authority record with a 1xx tag in (valid heading) for a
tag in a bibliographic record

AND

The same term exists as a 4xx tag (invalid heading) in another authority record

THEN

The MARC Heading Conflict Flag parameter in the Profiler determines what happens
when the 1xx/4xx conflict occurs.

e If the MARC Heading Conflict Flag is set to YES, Virtua automatically replaces the
bibliographic record’s heading with the conflicting authority record’s 1xx heading.
The bibliographic record is saved to the database.

e If the MARC Heading Conflict Flag is set to NO, Virtua warns the cataloger of the
conflict. The bibliographic record is put in error state because Virtua cannot
resolve the conflict.

rﬁ" Messages - Phoenix99 E]@-\

Record Update failed

irarming: Mo authior permanent authorty for heading: 100 $a
Fodhiguez, Marco

Error: Corflict exists as €22 0 %a Language and ethnicity
Ervor: Cataloging error: Corflict exists as dx

A

When the record is placed in error state, Virtua also identifies the heading causing the
1xx/4xx conflict on the Records by State window.
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W Records by State - Phoenix99

Murnber of state records found:

| Record |D | Date Uzer State

1 000135123 |2010M1722 | =taff Eror
2 000356439 (201011722 staf Errar
3 000356443 201001722 staff Enar
4 000356444 |2010M1/22 =taff Eror
5 0003564da 201001722 staff Enar
B 000356446 |2010M1/22 staff Eror
7 000356450 201001722 staff Enar

LDR 00423namm a22001 67 a 4500

oo vil=s000356450

ons MeFayc

oS 20101122123500.0

s 101122 0000 engd

039 gy 201011221238 'z staff

100 1 ‘a Rodriguez, Marco

245 1 0 ‘& language studiesS'c Marco Rodriguez
650 0 'a Language and ethnicity

999 a VIRTUA40

999 ‘a LOADORTLO

999 ‘s WTLS5ORTO050% 000*2450*6500*3330+*9331 *9332

iifarning: Mo author permanett authaority for heading: 100 $a
Rodriguez, Marco

Error: Conflict exists as 43¢ 0 $a Language and ethnicity <€
Etror: Cataloging ervor: Conflict exists as dxx

Edit | Delete ‘ Cloze |

You will need to change either the bibliographic record or the authority record:

e Delete the term from the 4xx tag of the authority record so that an authority

record may be created for the term in the bibliographic record.

OR

¢ Change the 4xx tag of the authority record to a 5xx tag (see also)

OR

e Edit the term in the tag of the bibliographic record to match the valid authority
heading (the 1xx tag of the authority record containing the 4xx tag) so that the

bibliographic record contains the valid term.

Tip: Turn on the display of blind references in the OPAC when searching for the correct
term in the authority records. It may be that the valid term is not in use but has an
authority record in the database.

Note: For a complete list of problems that will cause a record to go into error state,
please see the Cataloging User’s Guide.
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Additional Access Points

Additional Access Points (AAPs) provide an additional link to a record on the Browse
results window. Often they will provide a link to a specific record when the main heading
has several associated bibliographic records.

Profiler Tip: You can use the Additional Access Points parameter to determine how Virtua
treats Additional Access Points (AAPs) in the browse list. See Creating Additional Access
Points in the Virtua Profiler: Cataloging Parameters User’s Guide for more information.

There are five types of additional access points:

Tag in bib Purpose

record

1xx \a \t Creates access point to the record that consists of the main
entry name and the title of the work

7xx \a \t Creates access point to the record that consists of the added

entry name and the title of the work.

4xx/8xx \a \t | Creates access point to the record that consists of the Series
entry name and the title of the work

Uniform title | Determines whether or not the 130 \a tag is used as an
additional access point

1xx/240 Creates additional access points to a record for records with 1xx
and 240 tags. (See example below.)
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¥ Browse - Customer Support Library

BE%]

Author: twain, mark

Hits | Terms

I =

Twain, Mark

146 | Twain, Mark, 1835-1810. [SRC=DLC]

Twain, Mark, 1835-1910. 5 novels

Twain, Mark, 1835-1910. Adventures of Huckleberry Finn [SRC=DLC]
Twain, Mark, 1835-1910. Adventures of Huckleberry Finn. Greek [AAF]

Twain, Mark, 1835-1910. Adventures of Huckleberry Finn. Portuguese [AAF]

3
1
0| Twain, Mark, 1835-1910. Adventures of Huckleberry Finn. Japanese [SRC=0C])
1
1

Twain, Mark, 1835-1910. Adventures of Huckleberry Finn. Russian [SRC=0C1)
= Twain, Mark, 1835-1910. Adventures of Huckleberry Finn (Tom Sawyers comrade)

W View Bibliographic Record - Customer Support Library

<] 2]

Ful MﬁRC]
001 viis000223641 -~
4 | oo NeFayC
005 20120501090600.0
008 S8063051968 bl j 0001 pord
— 020 \a BB00TE2626 ¢ 59.95
035 W (OCel Clocm3aaT 1323
035 8 & 201206010806 \b VLOAD \c 200701170233 \d VLOAD Yy 200406232043 'z load
040 8 HQB \c HQB
045 a HQEA
085 ‘a J813 \a TWA\a Porfuguese
100 \a Twain, Mark, \d 1835-1910.
240 0 \a Adventures of Huckdeberry Finn. |l Portuguess
245 1 0 ‘aAventuras de Huck /\c Mark Twain ; Texto em portugués de Herberto Sales,
260 ‘a [Rio de Janeiro] : \b Ediouro, ' 1969, »
[ Masked ﬁamc:yﬂm| | Edit |Hm:.—tah| m1m| Fhfmsh| Close |

=Jojed

You can determine additional access points by setting the Additional Access Points

(AAP) parameter in the Profiler.

Note: We recommend that you do not alter settings for this parameter on a production
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database. After you make changes to this parameter, you need to re-index your browse

headings.
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Gifts and Deposits Processing

Recommended
Workflow Explanation
When gifts or legal deposits are received, Virtua provides
CErdeiattteth a way to both record and acknowledge receipt via the
MARC R 541 tag of the MARC bibliographic record. The
ecord : ) . .
information from the subfields in the 541 tag are used to
v generate acknowledgment letters.
CO”EStL,‘creer the Summary
e Add a 541 tag to a new or existing MARC record
e Configure the Letter
. e Print the Thank you Letter
Print the e C(Clear the Thankyou.dat file
Letter(s)
Key Terms
v e (Immediate Source of Acquisition) 541 Tag
Clear the e Unicode Editor
Thankyou.dat e Text Editor
File e Thankyou.dat file
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Create or Edit the MARC Record

On the Cataloging toolbar, click the New Record icon or on the Virtua menu bar,
click File > Records - Create Record or Search the OPAC for the MARC record that
you wish to identify as a gift.

e If you selected a default workform in the Cataloging Options on the Options
menu, then that workform will appear in the MARC Editor.

e If you did not select a default workform, then the Create Record window will
appear allowing you to choose a workform.

[ oy

Create Record @
Lack in: | (2 Catalog - £ Ed-

) Mappings 110aulab,wfm circFly i fi
|Z)Mew Fixed Field Files acg. wfm carnrm, wim Fi
I Mew Workforms analytica,wfm cormrmlab wfm lu|
I MESAW analytich .wfm comp .wfm q
I Yalidate bool, wkm complab.wfm q
110au,wfm boolklab.wfm Frbresxpr.wkm |
< 2]
File name: " wafm
File:z of bupe: | User Workformz [*.wfm) j Cancel |

Complete and save the MARC record, adding a 541 tag (Immediate Source of
Acquisition), which contains information needed for the acknowledgment letter.
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Subfield Purpose Needed for
Thank You
letter

\a | Source of acquisition (NR) Name of the person or Yes
organization that gifted the material.

\b | Address (NR) Yes

\c | Method of acquisition (NR): for example, by gift, loan, | Yes
or purchase.

\d | Date of acquisition (NR) Yes

\e | Accession number (NR) The identification code No
assigned to materials acquired.

\f | Owner (NR) The individual or organization with legal No
custody over the materials.

\h | Purchase price (NR) No

\n | Extent (R) The number of items acquired. No

\o | Type of unit (R) The name of the unit of measurement, | No
for example, cartons.

\3 | Materials specified (NR) No

\5 | Institution to which field applies (NR) No

\6 | Linkage (NR) No

\8 | Field link and sequence number (NR) No

Note: (NR) indicates that it is a non-repeating field.

Reopen the record in the MARC Editor.

112

On the Virtua menu bar, click MARC Editor > Remember for Thank You Letter. The

Information

dialog box will appear.

-

Information

.-‘I

= Thank wou letter data from this record now resides in a file, (Thankiyou,dat)
\]:) You can prink this data and other previously stored thank, wou data by selecting the Prink Thank You Letters menu item.

Note: When you choose Remember for Thank You Letter, the system will append the
data in the 541 tag to the ThankYou.dat file. This allows all related bibliographic objects
to be processed together, which prevents multiple letters being generated for the same

gift.
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Configure the Letter(s)

Before you can print an acknowledgement letter, you must configure the letter. Virtua
provides a sample thank you letter in English, which can be edited or translate using a
Unicode text editor:

e If you are using Windows 2000 or higher, you can use Notepad.
e If the letter file contains only characters in the ASCII range, you do not have to use

a Unicode editor.

Note: Using the sample thank you letter template as a guide, your library might want to
create a different letter templates for each language you might need. You might also wish
to indicate the language in the filename.

&l zampleenglizhthankyou.tyl - Notepad H=] 3
Fil= Edit Fomat Help

[CURRENT_DATE] =
[MAME]

[ADDRESS_LINE_1]
[ADDRESS_LIME_Z]
Cear sir,
Thank you for your [METHOD] of:
[GIFT]Title: ,aAauthor: ,Publication Information: ,
ge %reatTy appreciate your generosity in providing this(these) item(s)
n

RECEIVE_DATE].

Sincerely,

Libby A. Librarian
Director

‘| | 4

-

Using this template in conjunction with printing data pulled from the tags in the
bibliographic record, this is what the printed letter would look like.

Note: The bracketed information indicates where the system finds the data to print. If
any of the information needed for the gift letter is not provided in the bibliographic
record(s), the line in the letter where that information would appear is omitted.

To edit the letter template file:

Open the template file sampleenglishthankyou.tyl using your favorite editor. If you
have accepted the default location for the Virtua installation, the file resides in the
VTLS\Virtua\Catalog directory on your PC.

Edit any text not surrounded by brackets [ ].
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Save the file. If desired, assign it a different name, but always use the extension .tyl
and put the file in the \Catalog directory.

Print the Letter

You may choose to use the same letter template for all recipients, or you may choose to
use different letter templates for each recipient in the ThankYou.dat file.

To print the same letter(s) for all recipients in the ThankYou.dat file:

Select File - Print Thank You Letters from the Virtua main menu.

The Thank You Letter Choice dialog box appears. The Letter Recipient textbox
displays the name of the first recipient (derived from \a of tag 541) in the ThankYou.dat

file.

.,

Thank You Letter Choice - Phoenix9%9

Letter Recipient: |Mew River Public Library

Chooze Letter:  |Sampleenglishthankyau iyl

v Lze Same Letter for Cther Recipients

.................................

QK Cancel

.................................

Choose the letter template file that you want to print. You can have any number of
files in this list, but only files with the extension .tyl appear.

Leave the check box Use Same Letter for Other Recipients checked to print the same
letter for all recipients in the ThankYou.dat file.

Click the OK button. The Print dialog box appears.
Choose the number of copies you want to print.

Click the OK button. Virtua prints the letters, which will list all remembered
bibliographic objects.
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To print a different letter for each recipient in the ThankYou.dat file:

De-select the check box Use Same Letter for Other Recipients.
Print the first letter.

The Thank You Choice dialog box reappears, this time displaying the name of the
second recipient.

Choose a different letter file.
Print the second letter.

The Thank You Choice dialog box will reappear for each recipient in the ThankYou.dat
file.

Note: The check box remains de-selected only during the current printing of the series of
letters. After the current printing, it returns to the default value, which is selected.

Clear the ThankYou.dat file

After you finish printing, you need to clear the data file ThankYou.dat of the bibliographic
information saved for this printing.

Select File > Clear Thank You Information from the Virtua main menu.

The system asks you to confirm the action. Click OK. The thank you letter file is
cleared. Now you are ready to start the gift/deposit receipt and acknowledgment
process again for new material.

If, after you clear all thank you information, you try to print another thank you letter, the
system will display the following dialog box:

F = =]

Confirm

P Are you sure wou wank to clear all the thank wou letter data vou've collected so Far?

-3

Cancel
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Other Cataloging Functions

Recommended
Outline Explanation
Analytic Virtua provides a number of additional features to aid
Records catalogers with their tasks.
Create Summary
Analytic e Create Analytic Records
Records e Hyperlink Analytic Records
e Generate an 880 tag
e Replace MARC records
Hyperlink e Translate records from UTF-8 to another character
Analytic set
Records
Generate Key Terms
880 Tag ¢ Analytic Record
e Character Sets
e Child Analytic
Translate e Component Part
MARC e Parent Analytic
Records e Special Statuses
Replace
MARC
Records

Create Analytic Records

An Analytic record is a cataloging record for an individual issue with a distinctive title that
is part of a larger bibliographic set. It may be part of a serial, a monographic series, or a
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multi-volume work. Analytic records provide a means of further describing the individual
entities in the set and linking them to the bibliographic record for the set.

Virtua allows you to create an analytic record for an individual title of a volume in a
monographic series or serial based on the parent bibliographic record. You can then
display the child analytic record (also called the component part) linked to the parent

bibliographic record and vice versa.

Note: This option is enabled only if the record is a MARC 21 or CATMARC record with a
bib level of m (monograph) or s (serials).

Open the parent bibliographic record in the View Record window.

Right mouse click and select Create Analytic Record from the pop-up menu

1

| W/ View Bibliographic Record - Phoenix99

i S BT

LDR 01520cam a22004091a 4500
001 wis000345057

NcFayC

2009041 4092200 0
08041452009 nyua b
2 2008025644

W (OCol C)ocn232358069
Yy 200904140922 'z mencarthu

W DLC v DLC \J BAKER W LNQ
\a 9781575652764

‘a8 1675652765 ¢ $10.95

%2 (OCol C)232358069

000 1 spa

3888882888

041 1 Waspatheng
082 0 4 WwiiiwER22
[ Masked

Bb Requests

Hold 8ib for Merge

Creste Holdings Record
Create Holdings from Workform

Create Analytic Record
Create Authority Record(s)...

Save Copy to Database

= %)

J

Refresh I

Closel

Virtua opens the MARC Editor with the 773 tag populated with data from the parent

record.
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[ o L[]

aG(HEE
COOCOEED
OE000000

N

~lm |G
~l|m =
LR I e Y e}

& MARC Editor - Phoenix99 M=%
|
|
|
|
|
|
|
|
|

[101122 000 0 eng d

W oplam wy (McFay CI00035345057 'a Gabriel, Mat. ¢ Sam y sus cuadrados de
zapatos £d Mew York o Kane Press,; c2009. W hath matters en espafiol. s
Sam's sheaker squares. Spanish '= 9781575652764
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[ 1fees J[I[]  [ewirrue |

|(aj Language matetial [ (&) Monographic Component Part j [ Mazked

< | F MARC 21 Bib: Boaok Mew Record hodified

vUntitled1 /

773 tag Data from parent record

subfields

7 - Position O type of main heading

7 - Position 1 form of main heading

7 — Position 2 value of type fixed field - the type fixed field is the parent’s
leader 06

7 - Position 3 value of bib level field

w (control 035 tag $a. If multiple 035 tags exist, the first 035 is used.

number)

a (main entry)
b (edition)

d (publication)

1xx tag. All indexed subfields of the first 1xx tag are used.

e If the parent record contains a 250 tag $a, that value is
placed in $b.

e If the parent record contains a 250 $e, that data is
preceded by a comma and space and is appended to $b.

e If there is no $b, one is created containing 250 tag $e
data.

260 tag $a, $b and $c

k (series) 440 or 8xx tag. The 773 $k is repeatable; a $k is created for
each 440 or 8xx tag found in the parent record.
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s (uniform title) 240 tag (unless the first indicator is 0 or 1). All indexed
subfields are used.

t (title) 245 tag $a, $b and $I (unless the first indicator is 0).

x (ISSN) 022 %a

z (ISBN) 021 or 020 $a

MARC 21 records - $a of the first 020 tag is used

CATMARC record - $a of the first 021 tag is used

9 The 773 tag is NOT automatically assigned the parent record’s
serials number in the child record’s 773 $9. The user must do
this manually

Edit as necessary and save the record to the database.
Hyperlink Analytic Records

Using the MARC View Editor in the Virtua Profiler, you can create to two types of
hyperlink searches of analytic records:

e From the parent analytic record you can find all component part records
e From a component part record you can find the parent analytic record

Two types of control humber searches are used to create these searches.

Parent Analytic Record search is used to find the parent analytic record from a
component part record. Virtua uses the information in the 773 tag, subfield $w of the
component part record and searches bibliographic records for matches in the tag
defined in the Analytic Record Control Number Source Tag.

Component Part Record search is used to find the component part record(s) from
the parent analytic record. Virtua uses the information from the tag selected in the
Analytic Record Control Number Source Tag from the parent analytic records and
searches the database for 773 tags, subfield $w to find all component part records.

To create a hyperlink from the parent analytic record to the child analytic record
(component part):

In the MARC View Editor, open View Bibliographic Record: Full Display.
Configure Analytical Children view data for tag 035, subfield $a.

Assign tag 035 subfield $a as a search hyperlink, choosing Control Number Link as
the search type.
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When the hyperlink is clicked in the OPAC, the Control Number Link search takes the
information from the 035 tag subfield $a of the parent analytic record and launches
a search of the 773 tag subfield $w of component part record(s). Any records which
contain the value from the 035 tag of the parent record will be retrieved.

Note: This example assumes the Client Cataloging Options/Other Options, Analytic
Record Control Number Source Tag is set to use the 035 tag. Adjust the directions
accordingly if the 001 tag is used instead.

To create a hyperlink from the component part to the parent analytic record:
In the MARC View Editor, open View Bibliographic Record: Full Display.
Configure the Analytic Parent view data for tag 773, subfield $w.

Assign subfield $w of tag 773 as a search hyperlink, choosing Local Number as the
search type.

When the hyperlink is clicked in the OPAC, the Local Number search takes the
information from $w of the 773 tag and launches a search of the 035 tag of all
bibliographic records in the database. The record which contains the value from the 773
tag will be retrieved.
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4 MARC View Editor - View Bibliographic Record: Full Display
File Edit Options Formak Language [

Primary Display

Tag Lakel Information Tag Information Fized FieldrSubfield Informatian “alue Translstion Information
Subject - topical ~ TTgaees v et
Subject - name R |
Added Entry
PreviousTitle
Meray Title
Date (yyyymmd) l—_|
Scided Author Mormal Tag =
Analytic Parent '
] Mumik Inclicat (8]
Analytic Children ) | e |” LU | ECUr
ety ‘ | " ) " .
Tag Lakel Fixed Field'Subfield Yalue Translation
Anahtic Parert & Show All Found | | |
(" Shaoww Only the First:
3 ‘ Delete ‘  Show Only the Last Mew ‘ | ‘
[ Show s Search Link 560 Tag Selection
|Ign0re 8580 j
[ Dizplay 830560000
Punctuation
CPAC Search Hyperlinks Beginning et
Search Type Mon-Filing Indicatar Linking Entry Fields MARC Code |
- Bi O '
CM: Bik I - one WRT Endfing Text
J (" First Indicator
[~ Show Search Links By Subfield | ¢ Second Indicstor |
Save Cancel

Generate 880 Tag

Virtua has the ability to generate 880 tags for the corresponding Romanized tags and to
pair the Romanized tag with the 880 transliterations.

Place the cursor in the tag for which you wish to generate an 880 tag.

Right mouse click and select Generate 880 tag. The Generate 880 tag window will
appear.
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[][om ] [isto0345057 1=
|:| |NcFaer |""“
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Cloe]  [oomwmn S
(oo JOI[] [omosumsa_ 1
OO0 Eomoms ——
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(e ](J0] [ _met o o chascer ) —
Ol JCI0] [ oy Moessamrs ——
Ol 00 [omoms - N ——
O 00 [eseres _ oo —
(e ]GlE] [omsuees o el I
(b)) [mseoss ol E—
mcanEl - ——
O G0 o L N
(e i) [omsat o | —
Ol J0[e] [ semysuscusa . aisnorty Recordts).. Ron Friz ;
w Authority Browese ¥
(E ] (et vk suenytome »
Ol 00 e ver —
OG0 [cwhmsens 1
CIEm I [scomponse —
Ol ICIC] [owms o T
B[N0 T e— —
Clem I o] [oommmms sowdrspwn ——
[1[es0 J[ ][7] [ia Mediciin de superficies w Novela juvend. @ bidex |
[(J[roo [+ ][] [ Frez, ronsia. |
DED I'I.&Fhamirez,ﬁtnad. l
I:II:IEI |1.ammmalta'3enespaﬁol. l
[(J[e=a 1] [ecownee |
| @) Language materiai | ) Monographitem *| [ Masked
<> MARC 21 Bib: Book oPAC
OPAC1

Virtua automatically does the following:

e Determines the next linking number if other 880 tags already exist in the record.
e Populates the linking subfield $6 of the 880 tag and the corresponding Romanized

tag with the linking number.

e If the Romanized tag you selected already has an 880 tag associated with it, the
existing 880 tag linking number will be used in the linking subfield 6 of the new 880

tag.

e Populates the Edit 880 Tag window with the appropriate subfields.
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Choose a script from the dropdown list in the Edit 880 Tag window.

7 Edit 880 Tag - Phoenix99 M=%
Scrpt: | j
Subfield | Data |
a
Saue Cancel

Enter the information in the appropriate subfields.

Save the information. The 880 tag will appear in the MARC Editor window.
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& MARC Editor - Phoenix99 =JoJEd
001 [ wtisnonz4s057 =
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[ & Gabriel, Mat.
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| 'a Sam's sheaker squares. || Spanish

'a Sarm y sus cuadrados de zapatos [ escrito por Mat Gabriel ; ilustrado por Ron Fritz
adaptacion al ezpafiol por Ama B. Ramirez,

[ ' Mew ork ;b Kane Press, o c2009,

[waz2p ool il ;e em

| 'a Math matters en espafiol

| ' "Concepto matematico | el area - grados 1-3."

| [ [TAl B o) [ N e o
o (o ol o [ 3%}

| 'a Wiith his brother's help, Sam figures out how to measure the size of the lawns he mows.
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Note: Virtua displays 880 tags below their associated Romanized tags. If you do not wish
to display the tags in this order, you may use the VTLSSORT tag to force the tags into a
different order.
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Replacing MARC Records

You can replace a MARC record with another MARC record and retain any holdings records
or item records associated with the original bibliographic record. You might want to do
this when you have created brief MARC records for acquisition purposes and wish to
overwrite them with full MARC records.

To replace a MARC record with another MARC record:
Open the record you want to replace in the MARC Editor.
Open the replacement record in the View Bibliographic Record window.
From the View Bibliographic Record window, right click to open the pop-up menu.
Select the Replace Record in Editor option.

The record in the View Bibliographic Record window will replace the record in the
MARC Editor.

Note: This option is only available if the record in the View Record window is a
bibliographic record and the most recently opened record in the MARC Editor is a
bibliographic record.

Translate Records

Your library may want to convert records in a local file that are encoded in a character set
or code page other than Unicode. You might want to do this in anticipation of loading the
records into your database at a later time. Records in a Virtua database must be in the
UTF-8 character set.

Note: You can use v-load for translating and loading large numbers of records but you
can use this function as an immediate way to convert local records even if you are not
importing them.

Select File > Records - Translate Records from the menu bar. The Batch
Character Set Translation window will appear.
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-,

Batch Character Set Tra...

MARC Record Files
CAProgram Files\WTL SWirus2010.°

Add Delete |

Source Character Set

MARCS -

Cotyett Cancel |

Note: The Batch Character Set Translation window supports 17 character sets other
than UTF-8.

Click the Add Button to choose the file(s) of local records you need to convert. The
Open File dialog box will appear.

Select the file(s) to open and click the Open button. The path and file name of each
file appears in the list box labeled MARC Record Files.

Note: All files must be in the same character set.
Click the down arrow in the Source Character Set pull-down list.

Choose the character set or code page that corresponds to ALL the record files in the
list.

Click the Convert button.
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Appendix A: Key Terms

1xx/4xx conflict: In authority records 1xx tags contain valid headings, and 4xx tags
contain invalid headings (see references). When a bibliographic record is saved to the
database, Virtua identifies all terms in the bibliographic record as valid headings and
either links the bibliographic record to an existing authority record (via the 1xx tag of
the authority record) or creates a new authority record with the term in the 1xx tag.
But if the same term exists in another authority record as a 4xx tag, then Virtua
cannot create an authority record for the term in the incoming bibliographic record. A
1xx/4xx conflict exists because the same term cannot be both a valid heading (1xx tag
in an authority record) and an invalid heading (4xx tag in an authority record).

Analytic Record: Analytic records provide a means of further describing the individual
titles in the serial, monographic series, or multi-volume set by creating a record for
each individual title and linking them to the parent bibliographic record.

Authority Heading: terms (authors/names, titles, or subjects) that are stored in
authority record fields and appear in an alphabetical index on the Virtua Browse
window after a Browse search.

Authority Note: A 6xx tag added to an authority record containing notes about the 1xx
heading.

Authority Record: type of MARC record that indicates the main (authoritative or
established) name (form) of an author and lists variations of that name, OR indicates
the main title of a book and lists variations of that title, OR indicates the main way to
refer to a subject and lists variations of ways to refer to that subject.

Cataloging Options: A window in Virtua that allows the individual user to set various
options for cataloging records, such as copy options, display options, default
workforms, etc.

Character Set: A defined list of characters recognized by the computer hardware and
software. Each character is represented by a number. The ASCII character set, for
example, uses the numbers 0 through 127 to represent all English characters (upper
and lower case) as well as special control characters. European ISO character sets are
similar to ASCII, but they contain additional characters for European languages.

Child Analytic: A cataloging record for an individual title that is part of a larger
bibliographic set (see also component part). It may be part of a serial, a monographic
series, or a multi-volume work. The child analytic record is linked to the parent
bibliographic record.

Component Part: A bibliographic item that is physically part of another bibliographic
item such that the retrieval of the part is dependent on the physical identification and
location of the host item (e.g., a chapter in a book, an article in a journal).
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Cross Reference: heading that appears in a Browse index because it exists as a 4xx tag
or a 5xx tag in the authority record for a valid heading. The valid heading is stored in
the 1xx tag in the authority record. When selected by the user, cross-reference
headings refer the user to the valid heading

Database Action: A setting for record loading that allows the user to dictate what will
happen when the record is saved to the database, for example, overwrite an existing
record, merge with an existing record, put any duplicate records in error state.

Duplicate Tests: The ability to determine whether a record being loaded into the
database is a duplicate of a record that already exists in the system based on identical
information in specified tags.

Established heading: a genre/form term heading that is equivalent to the heading
contained in the 1XX field or the same record. It links headings within a system or
from different thesauri or authority files.

Immediate source of Acquisition: the 541 tag of the bibliographic record. Virtua
requires information from this tag to generate thank you letters for gifts.

Invalid Heading: heading or term that exists as a 4xx tag in a MARC authority record. It
serves to refer the user from a heading that is not used (invalid) to a heading that is used
(valid). It should not be present as a 1xx or 5xx in any other authority record.

Label List: list of all labels defined for the selected workform.

Label Target: editable field containing the number of the MARC tag and indicators
associated with the label.

Language List: feature of the MARC Label Editor that allows a library to support multiple
translations of MARC Labels.

MARC Record: MAchine Readable Cataloging record.

MARC Record Format: Virtua uses four MARC record types defined by USMARC:
bibliographic, holdings, authority, and Community information. MARC Records are
structured according to the MARC standard: and each record contains a Leader, a
Directory, tags, indicators, fixed fields, and variable fields.

MARC Editor: An editor accessible via the Cataloging subsystem of the Virtua Client that
lets you edit records adhering to the MARC standard.

MARC Indicator: beginning with the 010 tag, all tags contain two indicators, each a
single character. However, some tags use only one indicator, some both indicators and
some do not use any indicators. When indicators are undefined, the character position will
be blank.
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MARC Label Editor: used to edit and or translate the default MARC field labels and
mappings to suit local needs. Virtua does not supply labels for all MARC tags so default
workforms that are modified to include additional tags may need to have labels for these
tags defined in the label editor in order to use the workform in label mode.

MARC Tag: 3-digit number that identifies the kind of data that follows in a MARC record,
e.g. the 245 tag marks the title information. Some tags are repeatable, for example, the
6XX subject added entries.

Merge Record: A cataloging or record-loading operation whereby the system follows
specific user-defined rules to handle an incoming record that matches a record already in
the database. The matching records will be merged; the incoming record will replace the
database record but the new record will retain specified tags from the original database
record.

Merge Rules: Rules that define which tags from an incoming record and which tags from
a matching existing record will be retained in order to create a new record with elements
of both records.

Online MARC Help: standard Windows online help that is available for every 2709 record
format that Virtua supports. You can access it from the Help menu or by pressing F1 for a
given tag in the MARC Editor.

Owning Location: permanent location, either physical or virtual, of an item. When the
permanent location is also the shelving location, Virtua does not need to distinguish
between Shelving Location and Owning Location. Nonetheless, Virtua does make the
distinction and uses the Shelving Location to determine circulation properties and
locations for filtering in the OPAC.

Parent Analytic: The bibliographic record for a serial, monographic series, or multi-
volume set, to which are attached child analytic records describing the individual titles
that comprise the set.

Permanent Authority Record: record explicitly created and processed as a MARC
authority record where the authoritative form of a heading is in the 1xx field, any See
reference headings are in the 4xx, any See also reference headings are in the 5xx fields,
and any notes and series information are in the 6xx fields.

Provisional Authority Record: record that is an authority record only by virtue of being
a bibliographic record with a 240 field or by virtue of having a term in one of the following
fields: 1xx, 4xx, 6xx, 7xx, 8xX.

Record States: functionality in Virtua that allows libraries to assign flags or “states” to
records to facilitate the viewing, storing, and editing of the records. The software supports
record states for authority, bibliographic, and patron records. Record states may be used
to review work by novice catalogers, hold records for overnight processing, or hold
records in error state until cataloging problems are fixed.
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See Also Reference: points from a related heading to another related heading, both of
which are valid. On the Browse window, the plus (+) sign next to a heading indicates a
See also cross-reference.

See Reference: points from an invalid heading to the valid, authoritative heading. On the
Browse window, the minus (-) sign next to a heading indicates a See cross-reference.

Special Statuses: library-defined code and definition that may be applied to an item
record. The code is used to describe a physical condition or location. Libraries can define
these statuses in the Circulation parameters of the VSC. Examples: On Order, In Process,
Missing, Billed for Replacement, At Bindery, Needs Repair.

Spine Label: label containing the call number that appears on the spine of the book.
Virtua provides a delimited text file that can be imported into a label program or word
processing program to produce spine labels.

Subfield: fields can contain a group of related information divided into sub-fields. In
MARC records, subfields are marked with a delimiter followed by a subfield code indicating
the type of information in the subfield. For example \c in the 300 field (Physical
Description) indicates that the subfield for the physical dimensions of an item.

Text Editor: program such as Notepad or Wordpad that allows you to edit text files
without adding formatting commands.

Thankyou.dat file: file that contains information from the 541 tag (immediate source of
acquisition) of a MARC bibliographic record for an item received as a gift. This file is used
to print thank you letters for gifts. Multiple records may be appended to the file. The file
should be cleared after printing thank you letters to avoid duplicating thank you letters.

UNICODE (UTF-8): 8-bit transformation of Unicode that is the internal character set of
all Virtua databases. Vload automatically converts any character set supported by our
implementation of Unicode into the UTF-8 format.

UNICODE Editor: text editor that supports Unicode. If you are using Virtua release 31 or
higher and your platform is Windows 2000, you can use Notepad. If you are using Virtua
release 31 or higher and your platform is Windows 95 or Windows 98, you can use an
editor such as SC UniCode, which you can download from the Internet.

Valid Heading: heading or term that exists as a 1xx tag and/or a 5xx tag in a MARC
authority record. It may or may not also be present in one or more bibliographic records
within a tag under authority control.

Validate: process of checking the tags, fields, and indicators of a MARC record to ensure
they conform to the rules file for that type of record.

Vericat: cataloging validation program that is shipped with Virtua but is an optional
installation. The program examines individual cataloging records by using a set of rules
for each MARC format, or each specific format within the MARC bib format, to identify
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non-conforming tags. The program may be activated upon saving a record or manually
from an icon on the cataloging toolbar. In addition, catalogers can also define their own
individual set of rules for each format. The rules for each format are contained in a text
file that can vary from workstation to workstation.

VTLS-Defined Tags: the 039 and 999 tags of the MARC record used by VTLS for various
purposes. For example the 039 tag is a non-editable tag that records information
regarding when a record was last modified and which staff member modified it.

Workforms: pre-defined templates used to create bibliographic records.
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Appendix B: List of InfoStation
Reports for Cataloging

Cataloging Report
Group

Notice

Function

134

Authorities List

Bibliographic Record List

Bibliographic Record Load
and Extract

Broad Cataloging Statistics

Cataloger Productivity

Cataloging Errors

Change Item Location by
Call Number Range

Indexed Words
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List of permanent authority records (as opposed
to provisional, or automatically generated,
authority records) that meet the authority type,
Cataloging Source Code, and date range criteria
specified in the report configuration.

List of bibliographic records that meet the criteria
specified in the report configuration.

Allows you . . .

Upload to the database a fixed-format or delimited
file of bibliographic information and specify
options to process the file and save the data in the
MARC bibliographic record format.

-OR-

Download bibliographic records from the database
and specify options to convert the data from the
MARC record format to a fixed-format or delimited
file.

Summary of cataloging statistics for different
record types.

Count of the bibliographic records cataloged by
each Virtua user during the date range that you
specify for the report configuration.

List of cataloging errors that meet the date range
and Virtua user criteria set in the report
configuration.

Allows you change the location and shelf location
in item records identified by the item-level call
number range specified in the report
configuration.

List of indexed words in the bibliographic records
in the database.
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Item Barcode List

Items Created List

Number of Records in
Database

Patron Record Load and
Extract

Production of Records by
User

Record Extraction Utility

Record Modification Utility

Records By State

Subject Bibliography

URL Checker
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List of items identified by barcodes that fall within
a barcode range specified in the report
configuration.

List of items that were created within a specified
date range or that have a barcode that falls within
a specified barcode N range.

Counts of bibliographic, item, holdings, and
authority records in the database based on the
criteria that you set in the report configuration.

Allows you . . .

Upload to the database a fixed-format or delimited
file of patron information and specify options to
process the file and save the data in the VTLS-
defined 2709 patron record format.

-OR-

Download patron records from the database and
specify options to convert the data from the 2709
patron record format to a fixed-format or
delimited file.

For each user specified, counts of bibliographic,
item, holdings, and authority records in the
database that have been created, modified, and
deleted and that meet the criteria that you set in
the report configuration.

Extract records in ISO-2709 format from a Virtua
MARC 21 database.

Allows you make global changes to records in the
database.

List of state records that meet the record state,
record type, user, bibliographic level, and date
range criteria that you set in the report
configuration.

Allows you select a set of subject authorities and
produce a set of related bibliography entries.

Checks on the viability of URLs in bibliographic,
item, and holdings records in your database.
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Appendix C: Cataloging in a
Consortium Environment

Authority Records

The Edit Non Local Fields in Authority Records parameter in the Virtua Profiler
determines whether or not authority records may be edited at the institutional level.

1. When the 'Edit Non Local Fields in Authority Records' parameter is checked, the user
has permission to:

e modify any field in non-LC/NACO authority records
¢ modify all the fields in LC/NACO authority records (records with a 010 tag)

2. When the 'Edit Non Local Fields in Authority Records' parameter is not checked, the
user has permission to:

¢ modify any field in non-LC/NACO authority records

¢ modify only local fields (those with \5 with the content of the local 003 tag) in
LC/NACO authority records (the user cannot modify non-local fields in LC/NACO
records)

Item Records
Item records are unique to an institution and to a location within that institution.

e item records at locations or sublocations linked to the log-in institution will display
first the list of item records

e when a user edits an item record, only those item classes, locations, and shelving
locations defined in the Virtua Profiler for the log-in institution will appear in the
pull-down lists on the Item Information window

e A user may view an item belonging to another institution but they will not be able
to edit or delete the item record.

e The barcode number of the item must be unique across the consortium.

Patron Records

Patron records are shared between institutions. Certain tags, however, contain
information allowing the records to be linked to a specific institution usually via an
institution code in subfield 5.
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e The following tags in patron records can contain consortium information:

Tag Description

007 tag Blocks

015 tag Patron Barcode

016 tag Alternate Patron Barcode
030 tag Patron Type Code

035 tag System Control Number
040 tag Record Source

042 tag Dates

043 tag User-Defined Blocks

245 tag Patron Type

247 tag Patron's jurisdiction or home library
271 tag E-mail Address

5xx tags Note fields

e the barcode number and/or the alternate barcode number of the patron must be
unique across the database

¢ When migrating patron data if the software detects duplicate patron barcodes (in
the 015 tags) or alternate patron barcodes (in the 016 tags), it will prefix the
barcodes with the institution's code in parentheses, creating a unique barcode.

e Barcodes with the institution prefix will be displayed as a list in the iPortal and client
when a barcode with multiple institution prefixes is entered.

Editing Patron Records

In the consortium environment, the ability to edit patron records will depend on two
factors:

e the institution that owns the patron record
e the institution code contained in the subfield $5 of those tags that support the
institution code.

Only staff at the institution that owns a patron record will be able to edit:

¢ global information, such as name and address.
e information that is specific to that institution, such as the patron barcode.

Staff at any institution can edit institution-specific information in a patron record as long
as that information is specific to their institution as identified by their institution code in
subfield $5.
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Appendix D: Authority Records

Virtua MARC format for authority records is based on the USMARC authority format. For
details about the content designations of the format, see the USMARC Format for
Authority Data.

MARC Tags

The basic MARC authority structure is as follows:

Tag Purpose

1xx established heading

4xx see reference

5xx see also reference

6Xxx notes and series information

The parallel content designation for the 1xx, 4xx and 5xx tags is as follows:

Tag Purpose

x00 personal name

x10 corporate name

x11 conference name

x30 title

x50 subject heading

x51 geographic name

x55 genre or form heading

Other important tags in the authority records are as follows:

Tag Purpose
001 Authority ID(auth-ID)
010 Library of Congress control number
008 The fixed field display
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Bibliographic Level (bib Ivl)

The bibliographic level value has three purposes: The bib Ivl:

e distinguishes between two records with the same 1xx field
e distinguishes between authoritative and non-authoritative headings
e can indicate Additional Access Point authority headings

Two Records with the Same 1xx Field

First, the bib Ivl value distinguishes between two records with the same 1xx field.
Currently, if you want an authority record for Mark Twain as a name AND as a subject,
you need to have two authority records. The bib lvl value distinguishes between the two
records.

The following bib level values are defined in Virtua:

Bib Ivl value | Purpose

y subject record (searchable as a subject)
author/name record (searchable as an author)
series title record (searchable as a title)

uniform title record (searchable as a title)

special library- defined record.

X
t

u

g author/title series record (searchable as an author)

z

d subdivision authority record (searchable as a subject)
w

genre/form record (searchable as a subject)

Authoritative and Non-Authoritative Headings

Secondly, the bib level value distinguishes between authoritative and non-authoritative
headings that appear in the Browse window of the OPAC. If you try to view an authority
record with any of the following bib level values, the software will display an error
message:

Bib Ivl value | Purpose

n Title record (searchable as a title, but the authority
record will not appear in the client)

o] Non- authoritative name record (searchable as an author,
but the authority record will not appear in the client)

p Non- authoritative subject record (searchable as a
subject, but the authority record will not appear in the
client)
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Additional Access Point Authority Headings
Thirdly, the bib Ivl value can indicate Additional Access Point authority headings as

follows:

Bib Ivl value

Purpose

AAP author/name record as distinct from the author
portion of a combined author/title field (searchable as an
author, but the authority record will not appear in the
client)

AAP title record as distinct from the title portion of a
combined author/title field (searchable as an a title, but
the authority record will not appear in the client)

AAP author/title record as distinct from the 1xx and 240
fields of a bibliographic record (searchable as an author,
but the authority record will not appear in the client)

AAP title record as distinct from subfield a of a uniform
title (searchable as a title, but the authority record will
not appear in the client)

AAP title series record as distinct from the title portion of
a combined author/title series field (searchable as a title,
but the authority record will not appear in the client)
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Appendix E: Generate Spine Labels
Using Word XP ®

Recommended
Workflow Explanation
Edit the Virtua saves spine label information to a text file that
Spine Label can then be used with a label program or a word
Input File processing program to generate labels.
Virtua comes with a default label input text file called
Y LabInput.txt along with your Virtua software. This file
Test the can be edited if needed to add or remove data elements.
Spine Label The default LabInput.txt file will create a label indicating
Input File .
only the location, call number, and copy number.
v Summary
Convert the e Locate the Spine Label text file
Spine Label e Open the file in a text editor
Input File e Identify data elements
e Distinguish between data elements and text
e Edit the Spine Label text file to add or remove
A data elements
Define a
Label File Key Terms
e Spine Label
e Data Elements
y e Text Editor
Merge the
Input file
with the
Label File
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Edit the Spine Label Input File

Open a text editor: an editor can usually be found in Windows® under Start >
Programs - Accessories > Notepad.

Select the Labinput.txt file which is located at C:/Program Files/VTLS/Virtua/. The
following default information should appear.

a8 labinput. txt - WordPad E@@

File Edit “iew Insert Format Help

DESH [BR #A % BR@

CALLEREAROUT
. COFY

For Help, press F1

Add data elements in the order in which you want them to appear on the label.

Data Element

Purpose

ABBREVLOC
ACCESSION
AUTHOR
AV-ACCESSION
BARCODE
BIB-ID

CALL

CALL BREAKOUT
CODE
COLLECTIONCODE
COPY

Advanced Cataloging Workflow-Based Reference Guide
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Abbreviated location

Accession number

Last name of author (bib record, first word in 1xx \a)
AV Accession number

Bar code number

Bib ID

Call number (bib, holdings, or item inheritance)

Call Number broken at spaces into multiple lines
Item class code

Collection code description

Copy number: The C.COPY in the default file is a
combination of inserted text, (C.) which can be
edited, and an element name (COPY) that will result
in the following output for copy number 2: C.2
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COPYZEROPAD Three digit copy number left padded with zeros

ENUMCHRONBREAKOUT | Enumeration & Chronology Units broken on white
space

ior e (o record, entre contents of 120 100
\a instead)

ITEMCALL Item level call number

ITEMCALLBREAKOUT Item level call number broken on white space

LCCALLBREAKOUT Call number broken on white space, after the first
letter and after each period in the main call number

LOC Location (permanent)

LOCBREAKOUT Location broken at spaces into multiple lines

NON-PARAMETERIZED Non-parameterized shelf location

NOTECONTENTS Note contents (505 $a)

PHYSICAL-DESCRIPTION | Bib tag 300, full subfield \a

-EXTENT

PREFIXCOLLECTIONCODE | Collection code prefix

TITLE Title and statement of responsibility (bib record 245
\a \c)

UNIFORM-TITLE Bib tag 130, full subfield \a

UNITS Enumeration/Chronology/Units

VERBOSE-TITLE Title (bib record tag 245 \a, \n, and \p)

Save the file.

Test the Label Input File

Search the OPAC for a record.
Open the associated Item Record in the Item Information window.

Right-mouse click to Append/Print Spine Label to the label file.
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¥, item Information - Porterfield Library System - |EI|5|

Itern Elements |Statistics

rEibliographic Infarrnation
Author: Read, Conyers, 1821-1959, ed,
Title: Bibliography of British history, Tudor period, 14285-16032 [ issued under th...
Edition: 2d ed.
rItemn Information what's This? |7
Barcocks: IlDDDDDB@? Anpend Print Spine Label I_
Ttem Class: IEIDDks ;I Claar Label Filz k
Reserves Item Class:l Patran Activity
Item LURL: I Check Out... I
Chieck I,
Location: IWiIson Library ;I e
Shelving Location: IWiIson Library ;I Item Boakings
Item Requests -
Bib Requests
MNurnber of Pieces: Il 3. Circulate Fieces: [ sudit Trail... J
Price: I—$DD Transaction Log... —
rCirculation Rules Parent Record —
& Use Matri € Use Loan Perod: |97 = Bibliographic Record ]
Alicwy Beguest: ¥ Print
Save
E-rnail
Delete | Edit | Refresh | Close |

The label will appear in the Append Label window and will include any added data
elements.

¥ Append Label - Porterfield Library System il

Wilsom -
Litarary _I
DAa315

28

1959

.1

Append Label to File Print Imrmediately |
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Convert SpineLab.txt file to Word Database

Before you can use the SpineLabel.txt file with Mail Merge in Word you must add a
header row to the file. This row contains labels for the fields of data or it can be left
blank. But Word requires that the first row not be a row of data.

Open Microsoft® Word.

&l Document3 - Microsoft Word = |
Eile Edit | ¥iew | Insert Format Tools Table Window Help Type a question for help r X
0@ (5 tormal vt o-o- | AQBORES BT s -0
1 Normal | @ Wb Layout h ~12 = B Z U == 4

Brint Layout
IIlﬂgutliﬂe e e —

T ——
Task Pane

| Toolbars » | Standard

Ruler Formatting

Bl Document Map AutoText

I 3 Header and Foaoter Control Toolbox
| Database L\\\‘J
- Iarkup Drawing
i = Full Screen Forms
- ZOaT., Frames
: tail Merge
- Outlining b
: Picture
<-\1 Feviewing
: Tables and Borders
; Yisual Basic
: Weh
- Wieh Tools
: Wiord Count
Z Wiardart
. Avery Wizard
- FOFMaker 4.0 B
Snaglt +

- Customize... j
= sE]z 4 |
Fage 1 Sec 1 141 At 1" Ln 1 Col 1 REC TRE ExT OWR English (0.5 A

Select View = Toolbars - Database from the Word main menu. The Database
Toolbar will appear.

By B & 23 t=b RS,
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Click the Insert Database Icon on the Database toolbar. The Database
window will appear.

20

Data

Data options

CILEry CEtions.,, | Takle futcFarmmat,, .,

Insert the data into the document

Insert Data... |

Cancel |

Click the Get Data button. The Select Data Source window will appear.

Select Data Source

21X

Laok in: I My Data Sources ﬂ - - @ X
+CDnnect to Mew Data Source.odc

\é‘-,a "@+New SOL Server Connection.odc

~ Toals +

My Metwark  File name: |
Places

j Mew Source, . | Open
Files of type IAII Data Sources (*.odcy*.mdb; *j

Carcel

N

Under Files of type, select all files (*.*).

Navigate to your Virtua directory. The default location is:

C:/Program Files/VTLS/Virtua

Advanced Cataloging Workflow-Based Reference Guide Last Revised: Oct 2017
*Updated to 16.1



149

Select Data Source llll
Look i [ virtua = &~ & K O B - Took-
Catalog engserprintporush. utf sarmpleenglishthank:
% DBTables erb.log F search.pdf
Histary Mew Acquisitions Files erb.rec ] m
centre_codes-country_codes_uc.rtf (] labinput. tet %) ssleayz2.dl
,o,i, i CIRCBACK . EXE ] libeayaz.dll Thankvou.dat
B CIRCBACK.INI acle.rec W virtua. exe
My distr ibutionprint.utf [Z] patterns. tet @)virtua.hip
Documents i) engeogprintzancelpa.utf pow rec “Hvirtua.ini
7 engogpr intpo.utf Qe En.res wiriua, bl
! I =l engogpr intporush,utf permissions. ot
Desktop engrmonprintcancelpo.utf @) permissions.hlp
engrmonprintpo.utf printvoucher .utf
engrnonprintporush.utf receipt.utf
#* engprintclairm, utf receivingreport.utf
Favarites engserprintcancelpo. utf %) roboexzz.dIl
engserprintpo.utf zampleenglishISSNthankyou. tyl
[=]
& | 2l
My Network  Flie name: > | Mew Sourca... Open
Places I J — | =
Files of type les (*,* - Cancel
[ Files (%) -~ y

Select the SpineLab.txt file and click the Open button. The Header Record
Delimiters window will appear.

Header Record Delimiters 2] x|

Data fields must be separated from each other by a character
called a field delimiter. Sirnilarly, data records must be separated
by a record delimiter. Use the lists below to select the

Field delimiter: Record delimiter:
A | [ e ~]
Preview:

WILSON , LIBRARY ,QE672, .873,C.1,,,,,,,,,, i’

lIlIIIIIlIlIlIllllllllllllllllllllllql

WILSON , LIBRARY ,QE655 , .C55,C. 1, , s srsrrss

., o
IIIIIIIIIIIIIIIJ‘IJ‘lllllllllllllllll’ﬂl‘__J

oK I Cancel |

The Field Delimiter should be set to a comma and the Record Delimiter should be
set to (enter).

Click the OK button.

The Database window will appear with the path to the data identified under the Get
Data button.
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Data source

Get Data... |

Data: D:\...\SpinelLab. txt

Data options

Table AutoFormat...

Insert the data into the document ————————

Insert Data... D I

Cancel |

Click the Insert Data button. The Insert Data window will appear.

osertpata ST

Insert records

[ Insert data as field

OK I Cancel I

Select either All or a range of records and click OK. The data from the SpineLab.txt
file will be imported into a Word table.

Note: The file does not contain a header row. In order to use your mail merge template,
you will need to add a header row containing either no data or field names.

To add a row of field names to the database, position your cursor in the first cell of
the table.

Select Table > Insert > Rows Above from the Word main menu. An empty row will
appear at the top of the table.
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i Document7 - Microsoft Word - 0] x|
Eile Edit “iew Insert Format Tools | Table | Window  Help Type a question for help - X
e Ean &Y &JDraﬂTable QEE@ B T =% - @ .

oo |FF s M0 s R | % % % .
24 MNormal v Times Mew Roman Delets Y |fa Columns to the Left . # - A~
- sz Salact P | & Columins to the Right
o |8 B[4 § [ RS, = |
Rows sbove
[x] A B B saitcels... =2 Rows Belaw b £ 5 [
Split Table Ze Colls..
Table AutcFormat...
AutoFit 4
Heading Rows Repeat
&
: Library | QB672 |, ’

e Tibrary | 0BG35 |2+ Sort.

= Library | QE&72 Formula...

_- Library | BE723.D Hide Gridlines

L | P
. Library | N8585 Table Properties

- Tibrary | PH 1064 e E

. Library | P10452 EB3 | C1

" Library | PE128 K8 [ 1967 | C1

= Library | PII49 555 |1

- Library | PI3491 235 C1

. Library | PH771 B38 [C1

= Library | F14% Hez | C.1 -

- Library | PI501 P35 [C1 :

L |
. 9

¥
= nl=|= ] »
Page 1 Sec 1 1/1 At 1" lni col1 REC TRK EXT OWR English (u.s) G4 4

Advanced Cataloging Workflow-Based Reference Guide

*Updated to 16.1

Last Revised: Oct 2017

151



152

In the empty row, type field names for the columns if desired.

e If you chose to add header names to the header row, these field names will
populate drop down menus in the Mail Merge tool.

e If you chose to leave the header row blank, Word™ will use the term
“AutoFieldName” for the first column, “AutoFieldName1l” for the second column,
“AutoFieldName2” for the third column, etc.

Note: The number of fields may vary between labels based on the information in the item
record. For example, if you use copy numbers in some but not all of your call numbers
then the columns of data may not all contain the same type of information.

i Document? - Microsoft Word - 0] x|
File | Edit Wiew Insert Format Tools Table Window Help Type a question for help v X
0 tiew.. CrbN p v - | HACI G 2 4 |B] 1 85% - a3,
= Open.. CHO wordred- [ BB | « [ | "RV [ MWk

Close
— *+x B I O 5%% 1=+ 1= = IE S # A~
| save N Crl+s | E] =)

| Save Ag.. "

el <ave as web Page... B -8 DEEEEEEREEEEEEEEEEEEEEEEEE-
B] Search...

Yersions...

Wb Page Preview

Create Adobe POF...

Page Setun... o1
[& Print Preview 1
&b Print.. CirkP C1

Send To 2 c1

] 1

Properties o

100 MautoMergeField. doc 21

2 O, ATraining GuideshCat_sdvanced.doc 1967 | C1

3 DY A Training GuideshCat_Begin.doc g 1

4 DYy Data Sources'spine_labels,doc C.l

Exit 1 -
= [ Wilsen [ Library [ FI501 [P5 | C1 £
i o
_'_ ¥
= mE]z 4 »
Page 1 Ser 1 1A At 1" lni caol 1 REC TRE EXT MR English (U.S) G4 4

Click File > Save to save the file as a Word Document.

Note: In Word XP, save the file to the My Data Source directory as this is the default
directory used for creating mail merges.

Close the file.
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Define Label

Open a new document by selecting File & New from the Word main menu.

Select Tools - Letters and Mailing > Envelopes and Labels from the Word main
menu.

&l Documents - Microsoft Word - 13| x|
Eil=  Edit Wiew Insert Format | Tools | Table indow Help Type & question for help v X
DEda® &R e g |V Spelingand Grammar... F7 E & BT % ~ 03 .

Read RRE| S "] "®( | h% kb,
wWord Count... L — i v = =
41 Narmal ~ Times MNew EES SIS EE Q- -A?

£ sutoSummarize...

= & & 2 el B

‘|2 Track Changes CirH+Shift+E A T

Cgmpare and Merge Documents... _

Protect Document. ..

Speech

Online Collaboration »

Letters and Mailings » | tail Merge Wizard...
Tools on the Web. .. Show Mail Merge Toolbar

-

. tacro |IEI Ervelopes and Labels. .. !
- Templates and Add-Ins... Letter Wizard...

T AutoCorrect Options...

- Customize. ..

Options. ..
-— £y Avery \Wizard..,

~ [
+

- )

n z

= sE]= 4| |

Page 1 Sec 1 171 At 1" Ln 1 Cal 1 REC TRE E£T OWR English (U150 jﬂ

On the Envelopes and Labels window, click the Label tab.

Advanced Cataloging Workflow-Based Reference Guide Last Revised: Oct 2017
*Updated to 16.1



154

Envelopes and Labels llﬁl

Envelopes  Labels |

=l

Address; B -~ [ Use return addres Prit |
ﬂ Mewy Document |

Cancel |

Cptions. .. |

|

E-postage Properties...

[~ Delivery point barcode Label
—Print Byery standard, 2162 Mini
® Full page of the same |abel Address

" Single label —
Row: |1 = Cu:nlumn:ll E‘

[~ add electronic postage

Before printing, insert labels in your printer's manual feeder,

Select Options. The Label Options window will appear.

2

Printer inforrnation
" Dot matrix
® Laser and ink je Tray: IDefauIt tray (Lpper Tray) j

Label inforrnation

Label products: | avery standard j

Product number:
2160 Mini - Address -

abel informatio

2162 Mini - Adcress e I RTA=Y Address
2163 Mini - Shipping Height: 1,33"
2164 - Shipping Width: 4"

2120 Mini - File Folder
2181 Mini - Filz Folder Page size:  Mini (4 ¥ x Sin)
5196 Miri - Diskette )

Details. .. Meww Label,.. | Delete | ()4 I Cancel
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Select the appropriate manufacturer from the Label products dropdown menu and

browse through the list of labels that appear in the Product nhumber list box.

155

e If your label appears in the Product number list, click Cancel. You will not need to

define a label.

e If your label does not appear in the Product number list, select New Label to
define a custom label. The New Custom Label window will appear

Mew Custom laser ilil
Prewvienw
Side margins
Top margin ‘
Wertical pitch Width ‘!l | il
B Height ‘ dawn
il
I 1
—Hhumber across———

Label name: |
Top margin: |D,5" E‘
Side margin; ID.12" E‘

Yertical pitch: |1.33" E‘
Harizontal pitch: |4" =]

Label height: |1.33 " E‘
Lahel width: |4" =

MNurnber across: |1 E‘
Murnber down: |3 E‘

Page size: IMini (4 tax5in)

=l
K, I Cancel |

Enter a name for the custom label in the Label name textbox.

Note: This name will appear in the Product number list box on the Label Options
window when you select Custom from the Label product dropdown menu.

Use the diagram in the preview box to set the measurements for your sheet of spine
labels. Click OK when you have entered dimensions in each data entry box.
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Merge the Records with the Label Template

Open a new Word document.

Select Tools > Letters and Mailings > Mail Merge.

&l Document8 - Microsoft Word

Fil=  Edit “iew Insert Format | Tools | Table  Window  Help

DezEdan &LV &
=ad | F-E
4 Mormal w Times Mew

& |8 & 2] Xl Bab!

o/ x|

Type a question far help - X

% sgpelling and Grammar...
Language
Word Count...

'/fj AutoSummarize...

Speech

‘|8 Track Changes Cir HShift+E
Compare and Merge Documents. ..

Protect Docurment,..
Onlineg Collaboration

7 OEB|E T % > @

"I R % k.
==|g-2-A- 2

TITIT
e
111
111
[Tha)

o
|

Letters and Mailings

4 || Mail Merge Wizard. .. R |

Tools on the Web...
IWacro
Templates and add-Ins...
F  AutoCorrect Options. ..
Customize. ..
Qptions. ..
Ay pyery Wizard. ..

Shawr Mail Merge Toolbar

P [& Envelopes and Labels...
Letter Wigard...

. - |
- <]
z- B[E]= | | B
Fage 1 Sec 1 1/1 At 1" Ln 1 Col 1 FEC TRE EXT CWE English US.) A
The Mail Merge Helper will appear as a side bar.
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Select Labels from the Select Document Type option menu.

2l Documents - Microsoft Word =10l x|
File Edit Wew Insert Format Tools Table Window Help Type & question for help * X
DEdsr &Ry 2RI «-o- @G HOREE B O e5% -3 .

= F17 B | neert word Field - | 57 M 4 P o BB Oy % O By

m s2 &

A Mormal = Times Mew Roman -2 ~ B I U E IE- |22 EE O- ¢ -A -
=== T AR e i
EI L I T T T B R B B - SRR BRI - SRR T AtiMailMerge v X

Select document type

wihat type of docurnent are you
working on?

i Letters

2 E-mail messages
i Erwelopes

: i Labels

- > Directary

Labels

- —

Print address labels for a group
rnailing.

-

- . Click Mext to continue,

: Steplof6

;’_ @ 9 Mext: Starting docurnent

- ¥

= a[g= < | 2

Page 1 Ser 1 1A At 1" lni cold REC TRK EXT OVR English (U5  Cd 4

Click on Next: Starting Document.
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i Documents - Microsoft Word o] x|
Eile Edit “iew Insert Format Tools Table Window Help Type a question for help v X
D8 SRV | IBERY oo H@HORESH B T 5% -,

(= =127 B | tnsert wiord Fisld - | 50 5] By M 4 P MR B | Ty 3 by Oa

4 Mormal + Timas New Roman 122 ~ B I U E O~ # A~
By 8 & 2L el BB,

| 1 | Lo | 3 | C 4 | 5 - La| € % Mail Merge v x

21x

Label Options

Printer information
: " Dot matrix
- ® |aser and ink je

Tray: IDefauIt tray (Upper Tray) j

[

Label information

- Label products: Iother JCustam

Product number;:

abel inforrnation

Spine | ahel - Clstor Type: Custom laser
. AE (2x4) - Address Height: F
i BSE (2%7) - Address o "
c_\l AE (2%3) - Address Widdth; L
AE (239 - Address Page sizer Letter (B8 %% 1110n)
AE (2%10)_a - Address ;I
c'n Cietails. .. Mew Label, ., | Delete | K I Cancel
"
= s[g)= |
Page 1 Sec 1 11 At 1" Ln1 Col1

REC TRK EXT OWR English (U.5.)

Select starting document

How do you want to set up your
mailing labels?

® Lse the current document
) Change document layout
) Start from existing document

Change document layout

Click Label options to choose a label
sizen,

B Label options...

Step 2 of 6

g MNext: Select recipients

«0»'4

4p Previous: Select document type

B

o

£~

Select Change document layout and then click on the Label options link. The Label

Options window will appear.

Select the label file from the menu of available labels and click OK.

Click the Next: Select recipients link.
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From the Mail Merge Helper select Use an existing list, then click on the Browse
link. The Select Data Source window will appear. This window defaults to the "My

Data Sources” directory.

il Document8 - Microsoft Word - 0| x|
Fil=  Edit Wiew Insert Format Tools Table  Window  Help Type a question for help r X
DEEHSY ERY {iBRY v-o- | @ POFEE & B 9 5% ~ B,

[ [E1 =7 B | insert word Field = | 52 [F] By #] | 1 4 » MR (B | Ty 25 Og B
44 Mormal + Left: 0.0 » Times New Roman v12 ~|B I U E E=S =T EE DA
By | BB 2R TR R,
E|.....3.......$.......$---.---$---.---*---.---$---.Tt#MailMerge v X
. [r——
I @ Use an existing list
i Select from Cutlook contacts
2|
0 Type a new list
Look in: | My Data Sources LI - - & K O * Tools =
= Use an existing list
+CDnnect to Mew Data Source,odc
J I +Mew SOL Server Connection.odc Use names and addresses from a file
o or a database.
i ) Spine Labels.doc
History
Browse. .,
'O"i | | Edit recipient list...
Iy
Documents
()
Desktop
_*]
Favarites
&
My Network  File narme: | Mew Source... Cpen
Places I J — | = LI
Files of type |all Data Sources (*.odc;*mdb; *. = | Cancel . Step3of6
4
N @ g Mext: Arrange your labels
. T . )
4 Previous: Starting docurnent
= a[@)= ! ol
Page 1 Ser 1 11 At 13" ln1 ¢Caolil REC TRK EXT OWR English (U.g.) G A

Select the Spine label file, navigating to the correct directory if you chose not to save
the file under My Data Sources. The Mail Merge Recipients window will open

displaying the first rows of data.
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3§ Documents - Microsoft Word

I=IEY
File Edit Wiew Insert Format Tools Table Window Help Type a guestion for help r X
NEEHsy SRAY {BEBRY a-c- HAQHORE & B T =% ~ @ .

(= F11=1 B | Insert'word Field~ | 0 [2] B (2] 4 4 1 (e N e - E e

4 Mormal + Left: 0.0 = Times New Roman

/el = A A e e

> 12

- B I U E=E

O-2-4A-.

El o & Mail Merge Recipients lllll‘. # Mail Merge - x
To sort the list, click the appropriate colurmn heading.  To narrow down the recipients Celect recipient
displayed by a specific criteria, such as by city, click the arrow next to the column heading. EECHIECIDIENTS
I s the check boxes or buttons to add or remove redipients from the mal merge. W Use an existing list
List of recipierts:
- 2 2 Select from Outlook contacts
. x| asutoMergeField | | AutoMergeFieldl x| AutoMergeFieldz o )
T wilson [Public PR © Type anew ist
- Wilson Public Library PNB1 | |use an existing list
- WWilson Public Library HDS3 e
- g Garcia Research Library ML1C celected fram:
A Rec Wilson Public Library ML33 [ADocurnents and Settings,Macryal M
Memorial Archives 296,574 FaL ' g oA
Garcia Research Library z200 | Select a different list...
N Wiilsan Public Library PQEe
0 3 N
. Wilsan Public Library P41 _ RSS2 Sel s
. = s a —
o | v
Select Al | Clear Al | Refresh |
. Bd.. | Edt. | vaidste |
T e %
o ords Eecords Eecords Eecords Eecords Eecords Eecords
i -
) TI Step3of6
. @ g Mext: Arrange your labels
¥ " .
4@ Previous: Starting docurment
= . = LI | j
Page 1 Sec 1 1/1 At 1,3" In1 Caol1 REC TRE ExXT OVRE English qusy — GE v
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Note: If you chose not to name the header row, note the header name of the last column

containing data.

Click the OK button, the mail merge command for <<Next Record>> will appear in

each cell of the labels file.

Click the Next: Arrange your labels link.
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&l Document8 - Microsoft Word o] x|
File Edit Wiew Insert Format Tools Table Window Help Type a guestion for help r X
DEeES8 Sy fBERS - H@QHOEE 4 B T 5% - @ .

(= F1=1 B | msertword Field~ | 57 5] By 2] 4 4 1 MR Iy Bs Dy R,
4 Mormal + Left: 0.0 = Times New Roman ~12 ~ B I 10 E
= A N e e

El.....&.......*---.---$---.---$---.---*---.---$---.T¢#Mailr\-’lerge v X
- |~y
If you have not already done so, lay
out your label using the first label

on the sheet.

To add recipient information to your
label, click a location in the first
label, and then click one of the
iterns below:.

i alext wlext wllext allext wllext wlfext ) add Hodk
- Eecords Eecords Eecords Eecords Eecords Eecord: PYETEEES (1

[27] Greeting line...

- ¢ Electronic postage. .,

" El mMaore itermes...
i When you have&ished arranging

your label, click Next., Then you can
- preview each recipient's label and
- make any individual changes.,
i whlext «Mext ezt ezt allext ablext

o ords Eecords Eecords Eecords Eecords Eecords Eecords Benlicatall bl

. You can copy the layout of the first
: label to the ather labels on the

_ page by clicking the button below,

Update all labels

Step4of 6

g Mext: Prewisw your labels

]
«0»'1_

4 Previous: Select recipients

B[E]= 4] | 0

Page 1 Ser 1 1/1 At 13" lni cal1 REC TRK EXT OVR English .5  Gdf /

Click the More items link. The Insert Merge Field window will open.
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3§ Document8 - Microsoft Word - Ol x|
Eile Edit “iew Insert Format Tools Table Window Help Type a question for help v X
heEaa Sy i BRS o-o- H@QHOEEZESH B T 5% ~ 3.

(= E1E B insertword Field - | 57 5] By 2] 140 4 1 » MR B s Ty,
4 Normal + Left: 0.0« Times New Raman *12 ~ B F U E == I=- iz = gE =0 & - & -
== A R N L =
4@ % Mail Merge v X
Arrange your labels
I Insert MSHGEE 21 If you have not already dane so, lay
. out your label using the first label
AEEE on the sheet.

- whutolerge " Address Fields ® Database Fields dd recinient info )

Fieldse huto To add recipient information to your

. Fields: label, click a lacation in the first

- MergeFieldl = . label, and then dlick one of the

pedutoerg - iUEDmEYQEE!E:SI B - iterns below,
. ; wllext LtoMergere aMext —
- eF1eld2}}{§Aut Records AutoMergeFieldz Eecord = Address biack...
. oMergeField AutoMergeFisid3 |—1 crasting l

SnuAutodder AutoMergeField4 =3 EESE) koo

eFielddnu ' SITSHBE *| Electronic postage...

- g M Fiel ALtoMergeFields o [FERED
) utollergerie AutoMergeField? Il Postal bar code...
i Ao ASutoMergeFields )

siln AutatergeFieldd El more items...

i iugumerge:ﬂe:gﬂ ‘When you have finished arranging
ﬁutDMergeF!el 1z your label, click Mext, Then you can
- AutDMergeF!el s preview each recipient's label and
e rmake ary individual changes.
. AutoMergeFieid14
: wllext wllext el allext _
AutatlergeField13 Replicate labels
o Eecords Eecords AutoMergeFieldis Eecord
- AutoMergeField17 ﬂ You can copy the layout of the first
label to the other labels on the
N Match Fields. . | page by chicking the button below,
i Update all labels
L -
i % Step 4 of 6
N [} 5 Mext: Preview your labels
. M ) -
4@ Previous: Select recipients
= =@ 4 | ol
Page 1 Sec 1 141 At 1.5 Ln4 Caol 2 REC TRK EXT OWR English (U.s) G4 Y
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Select the first merge field you wish to include and click the Insert button. The field
name will appear in the first cell of the label file. To add additional fields, select the
next field you wish to appear and click the Insert button. The field name will appear
next to the first field name in the first cell of the label file. Continue until all fields are
added. The first cell in the label file should look something like this....
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whutoMerge Fiel
deradiutoMergeF
1eld e duto Mer
geField3s«duto
MergeFielddne
AutolergeField
SpadutoMergeF
1eld fiz e duto Mer
geFieldTs

In order for each column of information in the data file to appear on a separate line in the
label, you will need to add a hard return at the end of each merge field. Place the cursor
between the first and second field codes

<<AutoMergeField>>| << AutoMergeField1>>

Hint: if word wrapping causes the data to run below the bottom of the cell, change the
font to a smaller size while you edit the layout of the cell.

Hit the Enter key. Continue until all field codes are on separate lines. After you do so,
the first cell in your label file should look something like this.....

lwAuto Merge Fiel
i
whutoMerge Fiel
dls
whutoMerge Fiel
d3s
whuto Merge Fiel
ddn
whutoMerge Fiel
d5s
whutoMerge Fiel
dffis

e frte Wl eamra Baad

Note: The data will display correctly even though word wrapping causes the merge fields
to run below the bottom of the cell.
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Click the Update all labels button on the Mail Merge helper window. The field
names will be copied into all of the cells in the label document.

&l Document8 - Microsoft Word 10| x|
File Edit Wiew Insert Format Tools Table Window Help Type a guestion for help v X
DS SRy | fBERS o-c- 4@ 0 B e -3

[ F11=1 B | neert wiord Field » | 57 [5] By 3] | 10 4 1 » MR B Db

4 Normal+10pt Le v TimesNewRoman  » 10+ B 7 U [E]E = = (= = = O~ A~
e e =L e
EI 1 & 1 C $ c o 1 $ 1 $ 1 $ x| & % Mail Merge v X
Arrange your labels
If you have not aready done so, lay
aut your label using the first label
ahutollergeFiel | «Mext «Mext «Mext wHext wMext on the ShE?F' ) i
dw Recordwetato | Recordswiéwo Recordweduto |Recordscduto |Records To add recipient information to your
- wautchlergeFiel IergeFields MlergeFields MlergeFields LlergeFields hlergeFi label, click a location in the first
N dln hutchlergeFiel |« futohdergeFiel |« AutohdergeFiel | cAutollergeFiel | «Autold !abEL and then click one of the
ahutoldergeFiel | dls dli dls dls dls iterns below.
- dd wlatcllergeFiel | wlutoblergeFiel wlatclergeFiel whutollergeFiel |«Autobl [Z] address badk...
a schutolergeFiel | d2u d2 dds d2s 2w o
3w ahutohlergeFiel | «AutohdergeFiel wAutchdergeFiel wAutollergeFiel |«Autohd [ Greating ne. .
- ahutoldergeFiel | d3x A3 d3s d3s 3 : .
- [0 clutollergeFiel |« AutohdergeFiel | Aol erzeFiel «hAutollergeFiel | cAutohi— E SIS PEsEE 2o
: wautohlergeFiel | ddw A ddn ddn ddn I Pastal bar code...
. | tutchlergeFiel |« futohdergeFiel |« AutohdergeFiel | «AutoblergeFiel | «Autold )
sl AL AL AL AL AL E Mare iterns...
. «Mext aMext whext w«Mext whext et . )
Recordoeaduto  |Recordwadato  |Recordwediuto  |Recordweduto |Recordwedito | Records when you hfave finished arranging
. MergeFields MergeFields MergeFields MergeFields MergeFields MergeFi ooy labe, Clrljck NE}.{t' Jh?rpj Ylou E'an
n chutobdergeFiel | «autoldergeFiel | «latoldergeFiel |« AutoblergeFiel | «utolhlergeFiel | cAutahd Rreview 8ath] recipient s 3hef an
make any individual changes.
dl dl dl dls dls dls
. whutchlergeFiel «futohdergeFiel |« sutobdergeFiel | «AutobergeFiel | «AutohlergeFiel | «futohd Replicate labels
o dn d2n d2n d2n d2n dn
chutobdergeFiel | «autoldergeFiel | «latoldergeFiel |« AutoblergeFiel | «utolhlergeFiel | cAutahd You can capy the layout of the first
: e e e e B B label to the other labels on the
- whutchlergeFiel «futohdergeFiel |« sutobdergeFiel | «AutobergeFiel | «AutohlergeFiel | «futohd 3572 5y 61 Ty e UL sty
: [ A A s A s Update all labels
. chutobdergeFiel | «autoldergeFiel | «latoldergeFiel |« AutoblergeFiel | «utolhlergeFiel | cAutahd k
. S ol S ol S A S Al S Al Sy
. «Mext wMext wMext «Mext «Mext «Mext LI Sten 4 of 6
Recordsedato  |Recordwetano |Recordsadano |[Recordsebuto |Recordsefiuto |Records s P
MlergeFields IlergeFields IlergeFields IlergeFields MlergeFields MergeFi o g Mext: Prewiew your labels
N whutallergeFiel | «futallergeFiel |« AutallergeFiel | «AutahergeFiel | cAutollergeFiel | cAutohl o
) At At Al At Al Al 4@ Previous; Select recipients
=m[E]z 4| | |
Page 1 Sec 1 1/1 At 2,2" Ln 12 Col 4 REC TRE EXT OWR English (W.5.) Gl A

Click the Next: Preview your labels link.
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&l Document8 - Microsoft Word o] x|
File Edit Wiew Insert Format Tools Table Window Help Type a guestion for help r X
NEEHsy SRAY {BEBRY a-c- HAQHORE & B T =% ~ @ .

@8 e P B | nsertword Fieid~ [$2][E % 8 14« 1 » MG B 20,

A Mormal + 10 pt, Le = Tirnes Mew Roman ~10 ~ B I U E EEIE-|EZEE O-&-A- .
B | BB 2 Cel R,
El 1 & B 1 $ 1 $ 1 * 1 $ |T ‘ ’MEII' MEI‘QE w

Preview your labels

Some of the merged labels are
previewed here, To preview
another label, click one of the

following:
- Wilson Wilson Wilson Garcia Wilson Metnoriz inient:
- Public Puhlic Puhlic Reseatch Public Archive: HECHIES &
. Library Library Library Library Library 286,574 @ Find a recipient...
- PH1042 P31 HLO57 WIL10S5 ML3561.I3 F3123
: 865 Jé6 I6 F349 F423 1964 Make changes
cl 1 1 1 1977 c2 ‘You can also change your recipient

- 1 list:
Edit: redipiart list. .,
When you have finished previewing
— your labels, click Mext, Then you

can print the merged labels or edit
individual labels to add personal

- Wilson TWilson WWilson Wilson Wilson comments.
) Public FPublic Fublic Public Public
. Library Library Library Library Libraty
) POEAL 6 FN4121 BF724 01569490021 | BT21.2
- A3 F516 (58 (GA1T (G
1950 c1 z1 . c1

Step sof 6
g Mext: Complete the merge

]
«0»'1_

Em.:@il j

Page 1 Ser 1 1/1 At 17" lne  Col 4 REC TRK EXT OVR English .5  Gdf /

4@ Previous: Arrange vour labels

The data will appear in the cells of the label file. If the data is formatted correctly,
click the Next: Complete the merge.

Note: If the data is not formatted correctly, click on the Previous: Arrange your labels link
to return to the label file and change the formatting (e.g. font size).
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File Edit iew

Insert

Format

Tools
DhEedoan LY | {FB2ERC v HGE WO
& = F1 51 B | Insert Ward Field - N R ! 3

Tahle

Window  Help

45 B T &%

Type a question for help -

B

£4 MNormal + 10 pt, Le » Times New Raman *10o -~ B 7 O E IE-|iE = ¢ O]~ # -~ & -
e B & LD R,
El | Y B cE oo R E # a| @ % Mail Merge * x
Complete the merge
Mail Merge is ready to produce your
mailing labels,
To personalize your labels, click "Edit
: Individual Labels." This wil open a
- Wilson Wilson Wilson Garcia Wilson Ilemoric {;Egsd?rc;mgaé \C'Vflqgmvg?rt?:ﬁﬁg
i Fublic Fublie FPublie Regearch Public Autehive: Iabelsl i ththe efite]
. Litrary Litrary Litrary Likrary Library 296.574 docuﬁwent g
_ PH1042 FPHEL HDS7 LIL10S MLIE561.13 F3123 '
- 865 J66 I6 F349 F415 1964 Merge
cl cl cl (o] 1977 c2 Py .
_ I 3& Print...
) Ty Edit individual labels...
iy
- Merge to new document
- Wilson Wilson Wilson Wilson Wilson
i Fublic Fublie FPublie Publie Public
. Litrary Litrary Litrary Library Library
o POEA16 PI4121 BF724 01560400021 BTZl.Z
- A3 Fila (358 .Gal¥ .G6
1950 o1 o1 [0 o1
- =l
EY
N o Stepoofe
. T ) A
48 Previous: Preview your labels
= s[@s 4 | ol
Page 1 Sec 1 141 At 1.7 Ln6 Col 4 REC TRK EXT OWR English (U.s) G4 Y

=1o]x|

X

MR 3.

Click on Print to print the labels,

OR

Click on Edit individual labels if you would like to see all labels in a Word document

before you print.
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Appendix F — Permalink Functionality
Overview of Permalink Functionality

Permalinks functionality can be purchased separately as an add-on to Virtua. Contact
Innovative Customer Services for more information.

A permalink is a permanent web address (i.e., a URL) that points to specific content. A
permalink remains unchanged indefinitely and continues to direct users to the specific
content even if the physical location of the specific content is changed over time.

Innovative’s permalink functionality allows libraries to create permanent links to
bibliographic and authority record content stored in a library’s database (or databases).

Note: In the future, Innovative may offer functionality that allows users to create
permalinks to digital assets such as photographs, posters, articles, and other digital
materials.

Libraries may wish to create permalinks that can be used. . .

e In citations within journal articles and other publications, to provide a permanent link
to the referenced content.

e By databases to directly reference authority record and bibliographic record data in the
database.

e By open access services to provide permanent links to aggregated content.

¢ In other similar services, such as VIAF (Virtual International Authority File).

A user that clicks on a permalink is directed to the Innovative permalink resolver, which
resolves the URL and displays the digital content to the user in Chamo or in Innovative’s
Drupal interface.

Note: Libraries that wish to use Innovative’s permalink functionality must first add
permalink 024 tags to the bibliographic and authority records in their database(s). In the
System Management: Cataloging User’s Guide, we describe several programs and scripts
that can be used to add permalink 024 tags to bibliographic and authority records in
batch.

Understanding the Permalink 024 Tag Format

When Virtua adds a permalink 024 tag to a bibliographic or authority record, the following
format is used:
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First indicator value = 7
Second indicator value = # (blank)
Subfield $a = complete permalink URL (including the database code from 003 tag and the

control number from the 001 tag)
Subfield $2 = "permalink"

Sample permalink 024 tag data:

024 7# $a http://permalink.snl.ch/bib/xxxxyyyyyyyyy $2 permalink

Note that the control number from the 001 tag (“yyyyyyyyy”) is unique within the Virtua
database, but may not be unique across several Virtua databases. Combining the 001 tag
control number with the database code from the 003 tag (“xxxx”) allows libraries to
create permalinks for records stored in different Virtua databases.

Virtua prevents users from deleting a permalink 024 tag from a bibliographic or authority
record.

Workflow for Creating and Using Permalinks

Once you have run the script and programs described above to create permalink 024 tags
in your database, you can begin to use permalinks.

1. Place a permanent link to a bibliographic or authority record in the location of your
choice. The URL for the hyperlink must follow the permalink URL format described
below.

2. When a user clicks on the permalink in Chamo or in the Drupal interface, the
Innovative permalink resolver intercepts the request.

3. The permalink resolver uses the permalink URL to identify the record that is being
requested.

4. The digital content is displayed to the user via Chamo or via the library’s Drupal
interface.

See the diagram below for an illustration of this process.
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The diagram below describes the format for a permalink URL. This standard format allows
the software to identify and retrieve a specific record from a database.

http://lpe rma|ink.snl.chl/lbibl/lxxxxyyyyyyyy\{/lYYY\l(

Identifies the URI of the
institution that hosts

the permanent link

Identifies the
record type
(‘bib" or ‘auth’)

A unique identifier. oo’
represents the code from the
003 tag that identifies the
database where the record is
stored. ‘yyyyyyyyy' represents
the control number from the
001 tag, which identifies the
record.

Understanding the Permalink Resolver
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When a user clicks on the permalink, the Innovative permalink resolver intercepts the
request, resolves the link, and the record is displayed to the user via Chamo or via the
library’s Drupal interface.

As described above, the permalink URL must conform to the following format:
http://permalink.snl.ch/bib/xxxxyyyyyyyyy/YYYY

When a user clicks on a permalink, the Innovative permalink resolver uses the following
process to identify and display the bibliographic or authority record:
e The “permalink.snl.ch” portion of the URL identifies the institution to which the

permanent link belongs.

e The next portion of the URL, “bib” or “auth”, specifies whether the requested record
is a bibliographic record or an authority record.

e The following portion of the URL, “xxxx"”, is the code from the 003 tag of the record
that identifies the database where the record is stored. This allows the software to
handle permalinks to records that reside in different library databases.

e The next portion of the URL, “yyyyyyyyy”, specifies the unique control number from
the 001 tag of the target record.

e The final portion of the URL, “"YYYY"”, is optional and specifies the record format
(“html” or “"xml”). Note: Additional formats (DC, Mods, or Mads) may be supported in
the future. As of March 2015, Chamo supports only the html format.

Using each component of the permalink URL, the permalink resolver is able to identify the
exact record that is to be displayed to the user.

Configuring Your Web Server

Get the latest copy of the resolver.php script from Innovative Customer Services.

The resolver.php script expects the permalink path (everything after the host address)
to be provided in a request parameter named 'url'. The web server must be configured to
take care of this. To do this in apache2, enable the url rewrite module (mod_rewrite) and
add the following lines inside the appropriate VirtualHost field:

RewriteEngine On

RewriteCond ${REQUEST FILENAME} !-d
RewriteCond % {REQUEST FILENAME} !-f

RewriteCond % {REQUEST FILENAME} !-1

RewriteRule " (.*)$ /resolver.php?url=S$1 [QSA,L]

Restart apache2 after making these changes.
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Viewing Permalinks in the Chamo Interface: An Example

Permalink 024 tags that are cataloged properly in the bibliographic record are
automatically displayed in Chamo.
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In the example below, a permalink 024 tag has been added to the bibliographic record for
the title Oven to Table Cooking.

¥ View Bibliographic Record - orion23

<l

Ful | 1tems  MaRC |

001
003

DR 0080dcan 22200229 4500

wils000003016
05C

005
00a
024 7
035
039

082

20150305105100.0
031020 00010 eng

‘a http: f{permalink.snl. ch /bib /O5C000003016 \2 permalink

\a pf000003016

\a 201503051051 b staff \c 201410291243 \d VLOAD \c 200504141100 \d VLOAD \c 200403141106 \d VLOAD Yy

200310201622 'z load
\a 641.71 Ellis

d

m

100 \a Ells, Audrey (B9 MARC Editor - orion23 = | B |
245 \a Oven to table cooking. [ Tlust

260 \a Londan : Hutchinson Beham, 003 031020 00010 eng d |
550 \a Baking 024 |[7][# \a http://permalink. snl.ch/bib/0SC0000030 16 \2 permalink | |
<o o : 035 | [[ ] \a pf0D0003016 |
_ _ [esz [ ][] [es4r7iels |
[ Masked M ] L] [eels, Audrey |
l:l l:l El | ‘\a Oven to table cooking. | Illustrated by Kate Simunek. |
|:| |:| |:| ['a Londan : Hutchinsan Beham. \c c |
L] [ I[o] [wBaking |
l:l l:l El [\a Casserole cookery |
L] [ I[o] [ Cookery |
] [ ][] [AVIRTUATTEM \p 10002 \G 10002 X 2 |6 1861000145233 \a 641,71 Ells |

|(a) Language material L' {m) Monograph,Ttem j [T Masked
<[ =] [T _~|{orac
WOPACT /

In this example, the permalink 024 tag data is:

024 7# $a http://permalink.snl.ch/bib/0SC000003016 $2 permalink

‘OSC’ represents the code from the bibliographic record 003 tag, which identifies the
database where the record is stored.

‘000003016’ represents the control number from the bibliographic record 001 tag, which
identifies the record.
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When you search for the title Oven to Table Cooking in Chamo, the permalink is

on the Item Details screen.
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displayed

VLS {i Chamo
9

Login Cart Heading Search Reserves Search

Search

Oven to table cooking. / lllustrated by Kate Simunek.

Ellis, Audrey
Record 1 of 1

DL

P L
IPermaIin http://permalink.snl.ch/bib/OSC0O00002016 I

No requests for this item. Request
Add To Cart

Total Ratings: 0

ool

Copies MARC Record Details Additional Information

Location Call Number Units Copy Number

[} Adult Non-Fiction Shelves 641.71 Ellis 0

Add To Cart| SelectAll| Clear Al

Current theme Default = @

Search History Clear H Mobile Chamo

Search

Advanced Search

< Previous Next > Return to search

Barcode Status

31961000149233 Available Request

Clicking on the permalink URL directs you to the digital content at its permanent location.
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Appendix G - Changes in this Guide

Changes for Version 16.1

No changes were made.
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